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ﬁ READ CAREFULLY BEFORE
USING FOR THE FIRST TIME

Your instrument is equipped with a NiMH battery. This technology offers several
advantages:

* Long battery charge life for a limited volume and weight.
* Possibility of quickly recharging your battery.

* Significantly reduced memory effect: you can recharge your
battery even if it is not fully discharged.

¢ Respect for the environment: no pollutant materials such as lead
or cadmium, in compliance with the applicable regulations.

After prolonged storage, the battery may be completely discharged. If so, it must
be completely recharged.

Your instrument may not function during part of this recharging operation.

Full recharging of a completely discharged battery may take several hours.

A NOTE: In this case, at least 5 charge/discharge cycles will be necessary
for your battery to recover 95% of its capacity.

To make the best possible use of your battery and extend its effective service life:

* Only use the charger supplied with your instrument. Use of
another charger may be dangerous.

* Only charge your instrument at temperatures between 0° and 40°C.
¢ Comply with the conditions of use defined in the operating manual.
¢ Comply with the storage conditions specified in the operating
manual.
NiMH technology allows a limited number of charge/discharge cycles depending
significantly on:
* The conditions of use.
* The charging conditions.

Please refer to § 9.5 for correct replacement of the battery.

Do not dispose of the battery pack with other solid waste. Used batteries
must be entrusted to a qualified recycling company or to a company
specialized in processing hazardous materials.
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CHAPTER 1

INTRODUCTION

/N\ WARNING /\

These safety warnings are provided to ensure the safety of personnel.
Please read and comply with these precautions:

This instrument is protected from accidental voltages of not more than
50V with respect to earth in measurement CAT IV. The guaranteed level
of protection of this equipment may be compromised if used in a manner
not specified by the manufacturer.

Safety is the responsibility of the operator.

All metal objects or wires connected to the electrical system should be
assumed to be lethal until tested. Grounding systems are no exception.

Never exceed the maximum rated voltage and current, and the mea-
surement category.

Never exceed the protection limits, and always comply with the condi-
tions and place of use, indicated in the specifications.

Do not use the instrument or its accessories if they appear damaged.

Use accessories that have overvoltage category and service voltages
greater than or equal to those of the instrument (CAT IV 50V). Use only
accessories that comply with safety standards (IEC 61010-2-031 & 32).

Wear the appropriate protective gear (insulating boots and gloves).

Check that no terminal is connected and the switch is set to OFF before
opening the device.

Use only the charging unit supplied with the instrument to recharge the
battery.

Troubleshooting and metrological verification procedures must only be
performed by qualified, approved personnel, or the factory.

NOTE: The potentials on the various rods used for an earth measurement
may be different if a nearby electrical installation is defective or certain
weather conditions prevail (thunderstorms). It is up to the operator
to decide whether to continue or postpone measurements in these
situations.
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1.1 International Electrical Symbols

Signifies that the instrument is protected by double or reinforced insulation.

This symbol on the instrument indicates a WARNING that the operator must
refer to the user manual for instructions before operating the instrument. In
this manual, the symbol preceding instructions indicates that if the instructions
are not followed, bodily injury, installation/sample and/or product damage may
result.

Risk of electric shock. The voltage at the parts marked with this symbol may be
dangerous.

Ground/Earth symbol

g B> B0

In conformity with WEEE 2002/96/EC

1.2 Definition of Measurement Categories

CAT I: For measurements on circuits not directly connected to the AC supply wall
outlet such as protected secondaries, signal level, and limited energy circuits.

CAT II: For measurements performed on circuits directly connected to the electrical
distribution system. Examples are measurements on household appliances or
portable tools.

CAT lll: For measurements performed in the building installation at the distribution level
such as on hardwired equipment in fixed installation and circuit breakers.

CAT IV: For measurements performed at the primary electrical supply (<1000V) such
as on primary overcurrent protection devices, ripple control units, or meters.

1.3 Receiving Your Shipment

Upon receiving your shipment, make sure that the contents are consistent with the
packing list. Notify your distributor of any missing items. If the equipment appears
to be damaged, file a claim immediately with the carrier and notify your distributor
at once, giving a detailed description of any damage. Save the damaged packing
container to substantiate your claim.

1.4 Ordering Information

Ground Resistance Tester Model 6472.............cccoecmrrrreccrmeennnnnnns Cat. #2135.51
Includes rechargeable NiMH batteries, optical USB cable, power adapter 110/240V with
power cord 115V US, DataView® software, ground tester workbook CD, carrying bag for
meter, product warranty and registration card and a user manual.
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Ground Resistance Tester Model 6472 Kit (150 ft)...................... Cat. #2135.52
Includes meter, rechargeable NiMH batteries, optical USB cable, power adapter 110/240V
with power cord 115V US, two 150 ft color-coded leads on spools (red/blue), one 30 ft lead
(green), two T-shaped auxiliary ground electrodes, set of five spaded lugs, one 100 ft AEMC®
tape measure, DataView® software, ground tester workbook CD, carrying bag for meter, car-
rying bag for kit, product warranty and registration card and a user manual.

Ground Resistance Tester Model 6472 Kit (300 ft)..................... Cat. #2135.53
Includes meter, rechargeable NiMH batteries, optical USB cable, power adapter 110/240V
with power cord 115V US, two 300 ft color-coded leads on spools (red/blue), two 100 ft color-
coded leads (hand-tied, green/black), four T-shaped auxiliary ground electrodes, set of five
spaded lugs, one 100 ft AEMC® tape measure, DataView® software, ground tester workbook
CD, carrying bag for meter, carrying bag for kit, product warranty and registration card and
a user manual.

Ground Resistance Tester Model 6472 Kit (500 ft)..................... Cat. #2135.54
Includes meter, rechargeable NiMH batteries, optical USB cable, power adapter 110/240V
with power cord 115V US, two 500 ft color-coded leads on spools (red/blue), two 100 ft color-
coded leads (hand-tied, green/black), one 30 ft lead (green), four T-shaped auxiliary ground
electrodes, set of five spaded lugs, one 100 ft AEMC® tape measure, DataView® software,
ground tester workbook CD, carrying bag for meter, carrying bag for kit, product warranty and
registration card and a user manual.

1.4.1 Kits, Accessories and Replacement Parts

Test Kit for 3-Pole (3-Point) Testing (150 ft) ................cccceeeiie. Cat. #2135.35
Includes two 150 ft color-coded leads on spools (red/blue), one 30 ft lead (green), two T-
shaped auxiliary ground electrodes, set of five spaded lugs, one 100 ft AEMC® tape measure,
carrying bag.

Test Kit for 4-Pole (4-Point) Testing (300 ft) ...................c.cccoeee. Cat. #2135.36
Includes two 300 ft color-coded leads on spools (red/blue), two 100 ft color-coded leads
(hand-tied, green/black), four T-shaped auxiliary ground electrodes, set of five spaded lugs,
one 100 ft AEMC® tape measure, carrying bag.

Test Kit for 4-Pole (4-Point) Testing (500 ft)...................cecciee. Cat. #2135.37
Includes two 500 ft color-coded leads on spools (red/blue), two 100 ft color-coded leads
(hand-tied, green/black), one 30 ft lead (green), four T-shaped auxiliary ground electrodes,
set of five spaded lugs, one 100 ft AEMC® tape measure, carrying bag.

Test Kit for 3-Pole (3-Point) Testing
(Supplemental for 4-Pole (4-Point) TeStiNG) ........ccvuveeeeeeriiiieeeeieiireeeee e Cat. #2135.38

Includes two 100 ft color-coded leads (hand-tied, green/black), one 30 ft lead (green), two T-
shaped auxiliary ground electrodes, set of five spaded lugs, one 100 ft AEMC® tape measure,
carrying bag.

Bag #6 - Carrying Bag for Ground Kits..........c..ccccccievieiiiciiiiee e, Cat. #2119.82
Tape Measure - AEMC® (100 ft) ......oooevviieeiieeieeeeeeeee e Cat. #2130.60
Ground Tester DVD/Workbook Set...........cccoiiiiiiiiiiiieiiceeciee Cat. #2130.64
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Set of two, 14.5" T-shaped Auxiliary Ground Electrodes.................. Cat.
Replacement - Carrying Bag for Model 6470/6472 .............ccccuc....... Cat.
Optical USB Cable..........ooeiiiiiiiiiie et Cat.
12V Battery Adapter (for vehicle use) for Models 6470/6472.............. Cat.
AC Current Probe Model MN82...........cccoviiiiiiiiienieeee e Cat.
AC Current Probe Model SR182..........ccccovviiiiiiiiiniiiee e Cat.
Replacement - Connection Lead for Models 6472/6474*................. Cat.
Replacement - Fuse, set of 10, 0.63A 250V 5x20 1.5KA.................. Cat.
Replacement - Calibration LoOp.........cccooeiiiiiiiiiiiiiie e Cat.
Safety Alligator Clip - Black (Rated 600V CAT IV, 10A).......cccccueee.. Cat.
Safety Alligator Clip - Green (Rated 600V CAT IV, 10A) .........c........ Cat.
Replacement - Battery, Rechargeable NiIMH 9.6V ........................... Cat.
Replacement - Power Adapter 110/240V ..........cccoveeeeiiiiieeeee e, Cat.
Replacement - Power Cord 115V US Plug.......ccccocvevieeiiiieeniieeee Cat.

#2135.39
#2135.40
#2135.41
#2135.42
#2135.71
#2135.72
#2135.75
#2135.81
#2135.82
#2140.53
#2140.69
#2960.21
#5000.13
#5000.14

*NOTE: The GroundFlex® Adapter Model 6474 is a factory supplied product only.

Order Accessories and Replacement Parts Directly Online

Check our Storefront at www.aemc.com/store for availability
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CHAPTER 2

PRODUCT FEATURES

2.1 Description

The Ground Resistance Tester Model 6472 is a portable measurement instrument
designed to measure:

» Bond/Connection Resistance (2-Pole and 4-Pole Kelvin sensing)
* Ground Resistance (3-Pole or 4-Pole)

* Ground Coupling Resistance

» Selective Ground Resistance

» Soil Resistivity (Wenner or Schlumberger method)

* Ground Potential

* Ground Resistance with 2 clamps (no auxiliary rods)

* Ground Resistance of Pylons with the GroundFlex® Adapter Model 6474
and GroundFlex® sensors allow the system to measure leakage current and
ground resistance of tower legs without disconnecting the overhead ground
conductor.

The Model 6472 measures from 0.01 to 99.99kQ and is auto-ranging, automatically
seeking out the optimum measurement range, test frequency and test current.

Easy-to-use - Simply connect the leads, select the test mode, press Start and read
the results. Up to 512 test results can be stored in internal memory for later recall
to the display or downloaded to a PC via DataView® software.

The large LCD is easy-to-read and indicates ground electrode resistance, test
voltage, current and frequency as well as individual electrode resistance, battery
status and more.

The Model 6472 is CAT IV rated to 50V and is over voltage protected to more than
250VAc against accidental connection to live circuits. The voltage is also displayed
on screen. In the event of a system fault, the Model 6472 can withstand 250VAc.

Additional features of the Model 6472 include a heavy-duty field case sealed
against dust and water when closed (the test button is also sealed against the ele-
ments); manual and automatic test frequency selection from 41 to 5078Hz; user
selectable 3-Pole Fall of Potential or 4-Pole Soil Resistivity test methods and user
selectable 2-Pole or 4-Pole Bond Resistance test method.
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The Model 6472 is powered by 9.6V, 3.5 Ah NiMH rechargeable batteries. An ex-
ternal recharger powered from 120/230V, 50/60Hz is included and provides for
testing while recharging. The Model 6472 can also be vehicle powered from an
optional 12V battery adapter (Cat. #2135.42).

The Ground Resistance Tester Model 6472 is rugged, easy-to-use and ideal for
maintenance crews performing numerous tests. It exceeds mechanical and safety
specifications for shock, vibration and drop tests per IEC standards. The adjustable
test frequency provides for rejection of high levels of interference, allowing it to be
used under difficult conditions such as high stray currents that affect accuracy.

2.2 Key Features

Ground Resistance testing using the 2 clamp method (no auxiliary rods
needed)

2- and 4-Pole Bond Resistance/Continuity Measurement (DC Resistance)
with automatic polarity reversal

3-Pole Fall-of-Potential measurement with manual or automatic frequency
selection

4-Pole soil resistivity measurement with automatic calculation of Rho (p) and
user selection of the Wenner or Schlumberger test method

3-Pole earth/ground coupling measurement

Manual and automatic frequency scan from 41 to 5078Hz for optimum test
accuracy in electrically noisy environments

Selectable test voltage of 16 or 32V up to 250mA of test current

Auto-off power management

Automatic recognition of all electrode connections and their resistance value
Stores up to 512 complete test results in internal memory

Optically isolated USB communication

Remote set up and operation of all measurements using DataView® software
Automatic report generation including the fall of potential plot

Rechargeable NiMH batteries from wall charger or vehicle power

Rugged dustproof and rainproof field case — IP54 rated in closed position

Grounding standards IEC 61557 parts 4 and 5 compliant

Includes DataView® software for data storage, real-time display, analysis,
report generation and system configuration
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2.3 Control Features
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Figure 2-1

Four terminals: H (Z) (auxiliary electrode), S (Y) (electrode), ES (Xv) (earth/
ground electrode) and E (X) (earth/ground electrode)

All terminals accept 4mm @ banana plugs. Terminals H (Z) and ES (Xv) also
accept special plugs for current clamps. S (Y) will take a shielded cable.

Connector for charging the battery (see § 9.4).
256 segment multi-line backlit LCD (see § 2.4).

Connector for an optical interface to a PC. Either an RS-232 or USB connec-
tion can be used (see § 8 - DataView®).

Connector to the GroundFlex® Adapter Model 6474 using a special adapter
cable .

Rotary switch: OFF position, 7 measurement functions (see § 5 and 6) and
SET-UP function (see § 4.2).

START/STOP button: Starts the measurement and compensates for the leads
(in the mQ measurement function - see § 5.2.1).

Six function buttons - see § 2.5
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2.4 Display

NOTE: External voltages will be displayed only on the small displays (A2 and
A3) without the view of the main display (A1). This helps to rapidly recognize
that these are measurements of external voltages.

Backlight: The backlight turns ON automatically when entering a function and turns
OFF after the function is complete. Press the DISPLAY button to turn it back on.

NOTE: In the Set-up mode, pressing the DISPLAY button also selects the
next configurable parameter.

A\ o) MB sxi0/10 0000 12

34
@ pw EARTH COUPLING 1 2 3 4 OK\\ ALL
S

D, PSS 508 ez
i '3Ju_u.u .

ALARM OBJ. TEST

e

=

————— e D ===

e SR w ey A3
‘ R T D] mA

COM ooy = , '. L' ’-'l,-' kQft
MEMMR CONFIG MANUALAUTO SWEEP Bl

Figure 2-2

Al Top main display
A2 Middle small display
A3 Bottom small display

If this symbol blinks during a passive measurement, a voltage of more than
42V is present at the tester’s inputs.

A If this symbol_blinks during an active measurement, the limits of use have
been exceeded.

If the symbol appears constant during an active measurement, the values
to be measured are unstable.

o)) Warning buzzer is activated
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A blinking symbol > (greater than) or < (less than) indicates that the
measurement range is exceeded.

If both symbols are blinking during a passive measurement, the values of
voltage and/or current are too small and are beyond the limits of use. The

>0r< resistance RPAsS displayed by the tester is then highly uncertain.
If both symbols are blinking during an active measurement, the values
to be measured are strongly varying (remedy: switch on smoothing of
measured values with SMOOTH function).
Indicates the battery charge condition; the segments represent the energy.
EARTH Indicates whether the 3-Pole EARTH measurement or the EARTH COUPLING
COUPLING | measurement has been selected.
Sx1/10 Indicates the sensitivity of the GroundFlex®: x1/10, x1, x10.
0660 Display of the number of turns in GroundFlex® sensors (1 to 4).
» Number of GroundFlex® sensors connected (1 to 4). If this symbol blinks,
34 the GroundFlex® may not be connected or the current ISEL measured by
the GroundFlex® sensor is too small and is outside the limits of use.
OBJ:TEST | Object and test number for storage in memory.

Ra
>0«

Indicates lead compensation for 2-Pole measurement is active

If blinking, indicates the value is ready to be overwritten with a new value

DISTANCE | or that a new value will be entered. If more than one value has to be
entered, use the CHANGE A W buttons to move to the next one.
FREQUENCY | Indicates the test frequency.
m Indicates that the secondary function of a button will be used.
SWEEP Indicates SWEEP mode - Used in 3-Pole and 4-Pole measurements.
MANUAL Indicates MANUAL mode - the user has to stop the measurement,
otherwise the measurement keeps on running.
AUTO Indicates AUTO mode - measurement stops immediately after all results
are available.
m If blinking, indicates the measurement had a disturbance when the mea-
surement was started.
CONFIG Indicates that the blinking value of AUTO/MANUAL mode, frequency,
voltage or DC current direction can be changed.
MR Memory recall - indicates the displaying of stored results is active
MEM Indicates that there is recorded data in memory. When blinking, it indi-
cates that the results need to be saved by pressing the MEM button.
REMOTE Indicates the instrument is remotely controlled by the RS-232/USB

interface.
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SMOOTH

Indicates SMOQTHing of the displayed measurement results.

QL

Indicates that a clamp is (steady) or should be (flashing) connected to ES.

g

Measured value (R, U, I).

/V A
4 v Indicates that the measurement is running.
i
ALARM Indicates the alarm is activated. An audible alarm will sound if the value
measured is above the limit defined in the SET-UP mode.
' Distances to be entered between earth electrode and supplementary
¥ electrodes or between earth electrodes.

Clamp should be connected to H.
If this clamp symbol blinks, the instrument is refusing measurement
because the clamp is not connected correctly.

Symbolizes the soil resistivity value (Rho): W or S indicates that Wenner
or Schlumberger method is used for the measurement (changed by the
Hz/OPTIONS button).

2.5 Button Functions

Starts a measurement and compensates for lead resistance (§ 5.2.1).

START/STOP | Measurement stops automatically (AUTO) or is stopped by pressing this
button again (MANUAL).
2 Selects the second function highlighted in yellow under the buttons.
Increases or decreases the value of the flashing parameter displayed or
# selects the next parameter. Press the button for a longer time to increase
the change of value speed at a faster rate.
> Selects the parameter to be modified or moves the cursor to the right.
MEM/MR MEM: Stqres measurements to memory.
MR: Retrieves measurements from memory.
DISPLAY/ DISPLAY: Displays all parameters of a measurement.
SMOOTH: Smooths the display of measurement providing a more
SMOOTH
stable result.
Hz/OPTIONS/ Hz/OPTIONS: Enables configuration of measurement functions.
DISTANCE DISTANCE: Available for soil resistivity and V potential measurements. It

allows the setting of values of distances used for Rho (p) calculation.

Ground Resistance Tester Model 6472

15



CHAPTER 3

SPECIFICATIONS

3.1 Reference Conditions

Influencing Parameters Reference Values
Temperature 68°F + 5.5°F (20°C = 3°C)
Relative Humidity 45 to 55% RH

Power Supply 9to11.2V

Frequency Range of Input Signal 0 to 440Hz

Capacitance Parallel to Input Resistance 0 uF

Electric Field <1V/m

Magnetic Field <40A/m

3.2 Electrical

3.2.1

Frequency Measurements

Measuring method: Digital with a sampling frequency of 4028Hz, low pass, FFT.
The frequency of the strongest spectral component is displayed.

Measuring rate: Display updates approx. 3 times per s.

Measurement Range 5 to 450Hz
Resolution 1Hz
Operating error + 2Hz
Min. input voltage 10mv
Min. current through a clamp 0.5mA
Min. signal strength for GroundFlex® 5mA

3.2.2 Voltage Measurements

Overvoltages up to 75Vrms are displayed as ">65V". Permanent overvoltages
between 70 and 75V at terminals H (Z) and E (X) can cause overheating of the

overvoltage protection varistor.

Voltages of more than 75Vrms lead to error message 31 (excessive external

voltage) or 32 (voltage measurement overrange).

If terminals H (Z) and E (X) are put into contact with the line voltage, the protection

fuse will blow.
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External Voltage Measurements

Measuring Method: Digital by sampling at 4028Hz, low pass filter, FFT.
The frequency of the strongest spectral component is displayed.

Measuring Rate: Display updates approx. 3 times per s.

Signal Conversion: TRMS or sum of all harmonics 10 to 450Hz during selective
earth measurements with clamp or by GroundFlex® sensors.

Measured Range 0.00 to 9.99V 10 to 65V
Resolution 0.01v 0.1V
Intrinsic error + (2% + 1ct)

Operating error + (5% + 1ct)

Input impedance Z,;, Zs ¢ (Zs.cs) 1.2MQ

Operating frequency DC and 15 to 440Hz

3.2.3 Current Measurements

External Current Measurements

Measuring Method: Digital by sampling at 4028Hz, low pass filter, FFT.
Measuring Rate: Display updates approx. 3 times per s.
Signal Conversion: Sum of all harmonics 10 to 450Hz

With Current Probe SR182

0.00 to 10.0 to 100 to 1.00 to 10to
MeasurementRange | g gqmn | gg.9maA 999mA 9.90A 40A
Resolution 0.01mA 0.1mA 1mA 0.01A 0.1A
Frequency range 16 to 49Hz 50 to 99Hz 100 to 400Hz
Operating error from
0.% 01 0% i +(10% + 2cts) + (5% + 2cts) + (3% + 2cts)
82?3%9;:“ from > 20% + (10% + 2cts) + (5% + 2cts)
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With Current Probe MN82

0.00 to 10.0to 100 to 1.00to 10to
MeasurementRange | g ggmn | goomaA 999mA 9.99A 40
Resolution 0.01mA 0.1mA 1mA 0.01A 0.1A
Frequency range 16 to 49Hz O 50 to 99Hz 100 to 400Hz
g%e[gt%gog;” fom | (15% + 2cts) + (7% + 2cts) + (5% + 2cts)
Operating error from

Oﬂ o 4090 \ > 20% + (15% + 2cts) + (7% + 2cts)

(1): The Model 6472 cannot detect whether a current clamp SR182 or MN82 is connected. In the case
of the MN82 clamp, with currents > 10A and frequencies < 100Hz the instrument will not display
any warning messages. It is the operator’s responsibility to observe the limits of use when using the

MNB82 clamp.

3.2.4 DC Resistance Measurements

Measuring Method: Voltage/Current measurement (Standard EN 61557 part 4)

Nominal Output Voltage: 16VDc (if resistance < 22Q the output voltage is reduced

to 10VDC)

Max Output Current: > 200mADC for resistances < 20Q

Max Overload (permanent): 50Vrms (protection up to 250V is guaranteed)
Max Inductive Load: 2 H

Max Interfering Voltage: 60Vpeak > 10Hz

Time for Auto Range Selecting: approx 5 s

Measuring Time: 8 s with automatic polarity inversion

Measuring Rate: 3 per s in manual mode

Lead Compensation: Possible from 0 to 5Q

Alarm Setting: “>” or “<” from 1 to 999Q (max 3 digits)

2-Pole mQ2 measurement

Measurement 0.12to 10.0 to 100 to 1.00 to 10.0to
Range 9.990Q 99.90 9990) 9.99kQ 99.9kQ)
Resolution 0.01Q 0.1Q 10 10Q 100Q

Intrinsic error + (2% + 2cts)

Operating error + (5% + 3cts)
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4-Pole mQ measurement

Measurement 0.020 to 10.00 to 100.0 to 1.000 to 10.00 to
Range 9.9990 99.990 999.90 9.999kQ2 99.99kQ)
Resolution 0.001Q2 0.01Q 0.1Q 10 10Q
Intrinsic error + (2% + 2cts)

Operating error + (5% + 5cts)

3.2.5 AC Earth Resistance Measurements
Measuring Method: Voltage/Current measurement (EN 61557 part 5)

Open circuit voltage: 16 or 32Vrms square wave (if current > 240mA the output
voltage is reduced to 10Vrms)

Test frequency: Selectable from 41 to 5078Hz (see table in § 6.2)
Short circuit current: > 200mAAc

Noise suppression: > 80 dB for frequencies 20% or more above or below the
test frequency

Max. overload: 250Vrms
Max. value for R, & Rg: 100kQ

Measuring time:  Short push on START: approx. 7 s for first value of R_ at
128Hz, then 3 measurements per s.

Long push on START: approx. 15 s for first value of R at
128Hz, then 3 measurements per s.

The following error indications refer to reference conditions with a test voltage of
32V, test frequency of 128Hz, R, and Rg = 1kQ, no external voltage.

The operating error of AC resistance measurements can be less than that speci-
fied for voltage or current because frequency characteristics of the voltage channel
are matched to those of the current channel.

Measurement of auxiliary electrodes R, R, R, R,
Measurement 0.14 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990 99.90 9990 9.99kQ 99.9kQ)
Resolution 0.1Q 0.1Q 1Q 10Q2 100Q2
Operating error + (10% + 2cts)

The START button must be pressed for more than 2 s. For frequencies between 41
and 256Hz, the resistance of the auxiliary earth electrodes is measured at the test
frequency set. At higher frequencies the resistance is measured at 256Hz.
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3-Pole earth resistance measurement R,

Measurement 0.09 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990 99.90) 9990 9.99kQ) 99.9kQ
Resolution 0.01Q 0.1Q 10 10Q 100Q
Intrinsic error + (2% + 1ct)

Operating conditions: R.<3xR,U; =32V

Operating error for R
Values for R, R, and R, Frequency (Hz)

R > 00 Rs <3kQ) 4110513 + (3% + 2cts)

R, +R)/R p= UL RS < .
" 30500 E 537 to 5078 + (6% + 2cts)
R, > 3kQ, Rs < 30k 4110513 + (10% + 2cts)

R, +R)/R

H< 5500 E R, > 30kQ, Rs < 100k 4110128 + (10% + 3cts)

Note: For a test voltage U ; of 16V, halve the value for R,..

4-Pole earth resistance measurement R_

Measurement 0.011 to 10.00 to 100.0 to 1.000 to 10.00 to
Range 9,9990 99.990 999.90 9.999kQ 99.99kQ
Resolution 0.001Q 0.01Q 010 10 100
Intrinsic error + (2% + 1ct)
Operating conditions: R.<3xR,U =32V
P J E W Operating error for R_
Values for R, R, and R, Frequency (Hz)
) R > 00 Rs < 3O 4110513 + (3% + 2cts)
(R, +Ry /R, Ly = 0€, RS < .
<3000 537 to 5078 + (6% + 2cts)
R, > 3kQ, Rs < 30kQ 4110513 + (10% + 2cts)
(R, + Ry /R, . 100
<5000 R, > 30k, Rs < 100k 4110128 + (10% + 3cts)

Note: With a test voltage U, of 16V, halve the value of R,,.

Selective 4-Pole earth resistance measurement with SR182 or MN82 clamp

Same characteristics as 4-Pole earth measurements with the following particular
conditions:

Minimum current: SR182, I >0.5mA
MN82, I >2mA

Maximum Ry /R ratio: SR182, (Ry/R;) <500
MN82, (R, /R;) <120

with R, + R_ <200
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3.2.6 Soil Resistivity Measurement p
Measuring method: Voltage/Current measurement (EN 61557 part 5)

Open circuit voltage: 16 or 32Vrms square wave
Test frequency: Selectable from 41 to 128Hz (see table in § 6.2)
Short circuit current: > 200mAAC

Noise suppression: > 80 dB for frequencies 20% or more above or below the
test frequency

Max. overload: 250Vrms
Max. value for R, R, R, R.: 100kQ

Calculation formula, Wenner: p,, =21 d R

ES’
S-ES

Calculation formula, Schlumberger: p, = (n (d2 - (A/2)%) / A) Rg ¢
Maximum value of P: 999kQm (display in kQft is not possible)

Measuring time:  Short push on START: approx. 8 s for first value of R, _, at

128 Hz, then 3 measurements per s.

Long push on START: approx. 20 s for first value of R_ ¢ at
128 Hz, then 3 measurements per s.

Measurement 0.00 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990) 99.90 9990 9.99kQ 99.9kQ)
Resolution 0.01Q 010 10 10Q 100Q2
Intrinsic error + (2% + 1ct)

The intrinsic error specified refers to reference conditions with a test voltage of
32V, test frequency of 128Hz, Rp»H, Rp»s, Rp»ES and Rp_E = 1kQ, no external voltage.

Operating conditions : R, .. <3 xR, and:

Operating error for Ry

electrode

R Jectrod <100k
electrode . (7% . 2cts)
Releclmde / RS-ES < 2000
R octoge < 50K
electrode - .
Relecmme/ R <10,000 + (15% + 3cts)
Releclmde < 10kQ .
Ryectoce / Roes < 20,000 +(20% + 1cf)

R, is the resistance of the earth rods R

cal.

R R

R, . assumed to be identi-

P-ES? ' “P-E’ ' VP-H

Note: With a test voltage U, of 16V, halve the value of R ..
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Measurement of auxiliary electrodes R, ,, R, , R, .., R,
Measurement 0.14 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990 99.90 9990 9.99kQ 99.9k)
Resolution 0.1Q 0.1Q 10 10Q 100Q
Operating error + (10% + 2cts)

The START button must be pressed for more than 2 s. For frequencies between 41
and 128Hz, the resistance of the auxiliary earth electrodes is measured at the test
frequency set. At higher frequencies the resistance is measured at 128Hz.

3.2.7 Earth/Ground Potential Measurements V Pot

Measuring method: Voltage/Current measurement

Open circuit voltage: 16 or 32Vrms square wave

Test frequency: Selectable from 41 to 5078Hz (see table in § 6.2)
Short circuit current: > 200mAAc

Noise suppression: > 80 dB for frequencies 20% or more above or below the
test frequency

Max. overload: 250Vrms
Max. value for R, & R;: 100kQ

Measuring time:  Short push on START: approx. 7 s for first value of R; at
128Hz, then 3 measurements per s.

Long push on START: approx. 15 s for first value of R_ at
128Hz, then 3 measurements per s.

Measurement Range | 0.00 to 99.99mV |100.0 to 999.9mV| 1.000 to 9.999V | 10.00 to 65.00V
Resolution 0.01mVv 0.1mv 1mv 10mv
Intrinsic error U, , + (5% + 1ct)

The intrinsic error specified refers to reference conditions with a test voltage of
32V, test frequency of 128Hz, R, and R = 1kQ, no external voltage.

Operating conditions: R_<3 xR, and:

RH Rs Freq. (Hz) US_E Operatmg error for US-E
<30 4110512 < 3mV + (10% + 10cts)
<1kQ 41 to 5078 > 3my
4110 1025 - (5% + dcts)
3t060kQ | 1to3kQ | 41to512 > 10mV -
310 10kQ | 4110128

Note: With a test voltage U, of 16V, halve the value for R,.
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3.2.8 Earth/Ground Measurements with 2 Clamps

Measuring method: Voltage/Current measurement with a rectangular AC signal
Induced short circuit current: < 26Arms (with SR182) < 5Arms (with MN82)
Signal frequency: Automatic: 1611Hz - Manual: 128, 1367, 1611 or 1758Hz

Noise suppression: > 80 dB at frequencies differing by 20% or more from the
test frequency

Max. interfering current: 20A
Max. value for R, R;: 100kQ

Measuring time: approx. 7 s for the first value of R

peak

Loopr theN 3 meas. per s.

Measurement Range 010109990 | 10.01099.90 | 100105000
Measurement frequency 1367Hz - 1611Hz - 1758Hz

Resolution 00l | o1l | 10
Operating error @ SR182 = (10% + 1cts)

(without external current) MN82 + (20% + 2cts)

Measurement Range 0.10 to 9.99Q | 10 to 30Q2
Measurement frequency 128Hz

Resolution 0010 | 010
Operating error SR182 * (20% + 2cts)

(without external current) MN82 not specified

(1): Observe the minimum distance between the two clamps according to table in § 5.8.

3.3 Data Storage
Memory Capacity: 512 test results (64kB)

Communication: Optically isolated USB

3.4 Power
Power Source: Rechargeable 9.6V, 3.5Ah NiMH Battery Pack

Power Supply: 110/220, 50/60Hz external charger with 18VDc, 1.9A output or
12VDc vehicle power

Fuse: 0.63A, 250V, 5x20mm, 1.5kA
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Battery Life:

Function Power consumed Typical number of measurements
Device off <5mW —

Voltage Measurement 1.5W 4500
mQ @ 49W 1500
3-Poles, 4-Pole © 49W 1500
p® 49W 1500
V pot. 49W 1500
2 Clamps 3.7W 2000
GroundFlex® 55W 1200

(1): Measurements in automatic mode at 25-s intervals - In sweep mode, the number of measurements is

divided by 3 or 4
@:With R =1Q

(3): With RH + RE = 1002
(4): With RH + RS-ES = 100Q2

3.5 Mechanical

Dimensions: 10.7 x 9.76 x 5.12" (272 x 248 x 130mm)
Weight: 7 Ibs (3.2kg) approx

Case Material: ULVO Polypropylene

Terminals: 4mm recessed banana jacks

Case Protection: EN 60529 - IP53 (cover closed)
Drop Test: Per EN 61010-1

Vibration Test: Per EN 61557-1

3.6 Environmental

Operating Temperature: 32° to 113°F (0° to 45°C); 0 to 90% RH

Specified Operating Temperature™: 0° to 95°F (0° to 35°C); 0 to 75% RH

Storage Temperature: -40° to 158°F (-40° to 70°C); 0 to 90% RH

Altitude: < 3000m

(1): This range corresponds to the one defined by standard EN 61557, for which an operating error including the
quantities of influence is defined. When the device is used outside this range, 1.5%/10°C and 1.5% between

75 and 90% RH must be added to the operating error.
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3.7 Safety

Electromagnetic Compatibility

This instrument satisfies the EMC and LVD directives required for the CE marking
and product standard IEC 61326-1 (Ed. 97) + A1 (Ed. 98).

e Immunity in industrial environment
* Emissions in residential environment.

Electrical safety according to EN 61010-1 (Ed. 2 of 2001)
Measurement according to EN 61557 (Ed. 2 of 2007) parts 1, 4 and 5.
CAT IV, 50V

Pollution Degree 2

*Specifications are subject to change without notice
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CHAPTER 4

OPERATION

A NOTE: For detailed information regarding ground resistance testing, see
the Understanding Ground Resistance Testing Workbook CD that was
included with the instrument.

4.1 General Operating Instructions

The Model 6472 has operating modes:
* Automatic mode for routine applications.

* Manual (Expert) mode in which the user can change the parameters of the
measurement functions.

A NOTE: Fully charge the battery before the first use (see § 9.4)

4.1.1 Automatic Mode
» Set the switch to the desired function.
* Make the connections appropriate to the function.

¢ Press the START/STOP button. The device makes the measurement and
stops automatically.

* Read the measurement result on the display and the relevant parameters
using the DISPLAY button.

» To save the information in memory, use the MEM button (see § 7.1).

4.1.2 Manual (Expert) Mode
» Set the switch to the desired function.
* Make the connections appropriate to the function.
» Select MANUAL mode.
» Choose various measurement parameters using the Hz/OPTIONS button.

* Press the START/STOP button. The measurement frequency or the direc-
tion of the current (resistance measurement) can be changed during the
measurement. To view their impact upon the measurement and the param-
eters relevant to the measurement use the DISPLAY button.
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*  When the measurement results are acceptable, stop the measurement by
pressing the START/STOP button.

« View the result on the display and toggle through the relevant parameters
using the DISPLAY button.

» To record the information into memory, use the MEM button (see § 7).

The instrument also incorporates a “SWEEP” mode (automatic execution of sev-
eral measurements at several different frequencies) It is used to indicate how the
measurement varies as a function of frequency. In this case, the device operates
as in the automatic mode and the measurement process stops after taking the
measurement at the final frequency.

4.2 Instrument Configuration (SET-UP mode)

To configure the Model 6472 parameters, turn the rotary switch to SET-UP:

« All the segments on the display are activated for 1 second and then the
“PUSH button” message appears on the display.

» Various parameters are accessible by pressing the corresponding button.

» The number or symbol which can be modified flashes. These are changed
using the SELECT button [»] and CHANGE buttons [A V].

* To exit SET-UP, turn the rotary switch to another position.

» All of the parameters that are modified are permanently saved until a new
instrument configuration is performed.

Test Frequency

Parameter to be modified Button Possible values
Date and Month Hz/OPTIONS (i¢ press) yyyy.mm.dd*
Time Hz/OPTIONS (2 press) hh : mm*
Baud Rate Hz/OPTIONS (3 press) 9.6k / 19.2k / 38.4k
Default configuration Hz/OPTIONS (4" press) yes / no
GroundFlex® Adapter Model 6474 Hz/OPTIONS (5" press)

55,92,110,119,128

measurements only)

Test Voltage 16 or 32V
Distance unit DISPLAY (1 press) m (meter) or ft (feet)
Alarm (for mQ and 2-Pole DISPLAY (2" press) ON/ OFF

direction (< or >)
value (1 to 999Q2)

Buzzer DISPLAY (3 press) ON/ OFF
Modbus address DISPLAY (4" press) 110 247
Memory used MEM (1t press) 000 to 512 (total
number of locations)
Memory location MR (1¢ press) OBJ:TEST

*International format date and time only
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CHAPTER 5

AUTOMATIC MODE

A VOLTAGE CHECK: The tester first checks for possible interference. If there
is an external voltage of more than 42V, the warning triangle /N will be
displayed. If measurements are being performed in AUTO mode and a
disturbance frequency is detected, the tester will automatically look for a
frequency that is different from the default 128Hz.

5.1 Switching the Test Voltage
Available in all functions except mQ and 2 Clamp.

If necessary, the test voltages can be switched to either 16 or 32V as follows:

* Press the HzZ/OPTIONS button, then press it again to make the output volt-
age (Uout) blink.

* Use the » button to switch to 16 or 32V, then press Hz/OPTIONS again.

This setting is retained when the unit is turned off.

5.2 Resistance Measurement mQ (2-Wire)

A WARNING: Before performing the resistance test, verify that the sample
under test is not energized.

1. Set the switch to .

2. Connect the resistance to terminals H (Z) and E (X).

H
g

@ o
—

ES
O

O (E)
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3. The 6472 makes a measurement with a positive current (R+), then reverses the
direction of the current and makes another measurement with negative (R-).

o) [} o) [}
® : -
R - o o o * R -' '- '-'
Q ,- -’l ' Q
- ‘RQLARM L Re (R+) + (R-) R/:LARM Ty
~ a 2 Lt
i L Q
@ AUTO “ @ AUTO
START/STOP

4. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

R+, R-, +U, ., *l, ¢ -U, . -, U-Act (U, . and its frequency) and R, if there
is compensation for the measurement leads.

5.2.1 Lead Compensation Measurement

Lead compensation subtracts the resistance of the test leads from the measured
result.

» Short the two measurement leads connected to H (Z) and E (X) terminals.

¢ Press the 2nd button, then the START/STOP button to start the measure-
ment.

* This value will be deducted from all resistance values measured thereafter
until the rotary switch is turned to another function.

P
H o)) i}
e %Q. ® +
R - - - - e
o3 o
v
RALARM n
(Exvsj L’,A R [ Y
oF: 0 ©
2nd START/STOP ® Auto

appears on the display after the compensation value has been measured.

A NOTE: If the compensation resistance is > 5¢, or if the leads are not shorted
when the measurement is started, the value of compensation will be canceled.
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5.2.2 Alarm Function

This function is active only for 2-Pole resistance measurements. By default, the
visual alarm (ALARM symbol flashes) and the audible alarm (buzzer sounds for a
few seconds) are triggered when R < 2Q).

This threshold can be changed using the SET-UP function:

Turn the alarm Access the Choose a low (<) or
ON or OFF type of alarm high (>) alarm

A

> A

Set the value of the alarm Complete the adjustment
between 1 and 999Q of the alarm setting

FE]

and DISPLAY
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5.3 Resistance Measurement mQ (4-Wire)

This measurement is used to improve the resolution (10x better than the 2-Wire
measurement) for weak resistance values.

To perform a 4-Wire measurement:

Press Hz/OPTIONS —>»  Press Hz/JOPTIONS once again
(AUTO will blink) (H and E will blink)

O=>
O=>

Hz/oPTIONS Hz/oPTIONS
Press » Confirm choice by pressing
(H, S, ES and E will all blink) —> Hz/OPTIONS again

U=
O=>

Hz/oPTIONS

WARNING: Before performing the resistance test, verify that the sample
under test is not energized.

1. Set the switch to .

2. Connect the resistance to all 4 terminals.

O

O (§)
e
o 5
o &
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3. Start the measurement by pressing the START/STOP button.

L

START/STOP

o) [}

® . (Jam ¢

@ ’ L..‘ ,.’ Q

@ RA;LARM ’l':'l':'l'l-:'l )
PP

® wro

4. To display the measurement parameters, press DISPLAY several times.

The device displays the following parameters:

R+, R-, +U, ., *l, . -U

H-E’

H-E? _lH-E’

U-Act (U,, . and its frequency)

5.4 Earth/Ground Measurement (3-Pole)

This function is used to measure an earth (ground) resistance with 2 auxiliary

electrodes.

There are several measurement methods, the full and simplified (62% method) will

be discussed in this section.

5.4.1 62% Method
1. Set the switch to .

2. Place electrodes H (Z) and S (Y) to form a straight line with the earth electrode

under test.

The distance between electrode S (Y) and the earth electrode is 62% of
the distance between electrode H (Z) and the earth electrode; the distance
between the electrodes H (Z) and E (X) should be 8 to 10 times the depth of

the rod you are testing.

H

Sk

O]
Of
s (Y)~J~ ®
O 15

KO—

|_distance d - 62% d
distance A> 80 m

I
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In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).

Connect the cables to terminals H (Z) and S (Y) (red and blue respectively); dis-
connect the earth strap from the rod under test, then connect terminal E (green) to
the rod or electrode system to be tested.

3. Press the 2nd button, then the DISTANCE button. The "hundredths" will blink.

o) MI}

®R

H £ - o o o

| ®

it

: o

A ?ISTANCE

1 S
00O i,

® AUTO

2nd DISTANCE

4. To modify the hundredths (of meters or feet), press the A button until the
desired digit is displayed (0-9).

5. To select and modify the tens, press the » button and then the A button until
the desired digit is displayed (0-9).

6. To select and modify the units and tenths of a unit, press the » button and
then the A button until the desired digits are displayed (0.0-9.9).

7. To terminate the programming of distance, press the 2nd button and then the
DISTANCE button.

It is also necessary to program distance A. This is done in the same way as for
distance d.

8. Start the measurement by pressing the START/STOP button.
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9. To display the measurement parameters, press DISPLAY several times.
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The device displays the following parameters:

Re, Ugpe | e U-Act (U, . and its frequency, Ug . and its frequency).

To measure the resistances of auxiliary electrodes H (Z) and S (Y), or if the resis-
tance of the electrodes is too high (see § 10.1), start the measurement with a long
press of the START/STOP button.

R, R will be displayed.
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START/STOP
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NOTE: Repeat the process at 52% and at 72% for the S electrode.

5.4.2 Full Method

A more thorough measurement can be obtained by taking measurement by mov-
ing the S (Y) auxiliary electrode every 10% between H (Z) and E (X) and plotting

the results. A distinct plateau should result as shown below.

R20
R10

R30 R40 R50 Reo R70

R80

R90

0 10 20

Take the average of the 3 or 4 readings on the
plateau to obtain the earth electrode resistance.

30 40 50 60 70
% H-E

80

90 100

R = R40 + R50 + R60 + R70

4
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5.4.3 Recommendations for a Reliable Measurement

Moving the Auxiliary Electrodes

Move electrode S (Y) towards electrode H (Z) by a distance equal to 10% of d and
make another measurement. Then move electrode S (Y) again by a distance equal
to 10% of d, but towards the earth electrode.

o

- - . Sk

H(2) ! S(\L)i | ;l’/ O

T T !

[ [ [ [ 52%d ¥
62% d

A

The 3 measurement results should be the same to within a few percent. If this is
the case, the measurement is valid.

If not, electrode S (Y) is in the zone of influence of the earth electrode. It will be
necessary to increase distance d for the H (Z) auxiliary electrode and repeat the
measurements.

Positioning of the Auxiliary Electrodes

To make sure that your earth measurements are not distorted by interference, we
recommend repeating the measurement with the auxiliary electrodes placed at a
different distance and in another direction (for example, rotated 90° from the first
alignment).

HZ)e ,
sS(Y)e |
H(2) S (Y)
) ° EX)e ¥

) 3 '

If you find the same values, your measurement is reliable. If the measured values
are substantially different, it is likely that they were influenced by earth currents or
a groundwater source. It may be useful to drive the electrodes deeper and/or wet
the ground near them to reduce their contact resistance with the soil.

Avoid routing the connecting cables of the earth electrodes near or parallel to other
cables (transmission or supply), metallic conductors, rails, or fences: high test fre-
quencies may cause cross-talk and affect the measurements.
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5.5 Earth/Ground Measurement (4-Pole)

5.5.1 Measurement without a Clamp

This function is suited to the measurement of very low earth resistances. It
provides better resolution (10x better than 3P measurement) and there is no need
to compensate for the resistance of the measurement leads.

1. Set the switch to .

2. Place electrodes H (Z) and S (Y) at least 30m apart.

92

O §

! L o0&

H(2) S(Y) ‘i T/ | e’[:
i i T of+

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.). Connect the cables to terminals
H (Z) and S (Y); disconnect the earth strap from the rod under test, then connect
terminals E (X) and ES (Xv) to the earth electrode to be tested.

3. Start the measurement by pressing the START/STOP button.
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4. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:
R, U

op lne U-Act (U, . and its frequency, U . and its frequency).

To measure the resistances of auxiliary electrodes H (Z) and S (Y), or if the resis-
tance of the electrodes is too large (see § 10.1), start the measurement with a long
press of the START/STOP button.

R,: R, U, ¢ will be displayed.
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We recommend repeating the measurement with the auxiliary electrodes placed at
a different distance and in another direction (see § 5.4.3).

5.5.2 Measurements with a Clamp

For this selective earth measurement you need a current clamp, either a Model
SR182 or Model MN82 (both available as an accessory). These two types of
current clamps are specially designed to work with the 6472 ground tester.

The SR182 is more precise, suited to the measurement of higher currents (up to
40Arms) and for use on thicker conductors, while the MN82 (which is easier to
handle) accepts currents up to 10Arms and can be placed on conductors up to
3/4" (20mm) in diameter.

1. Set the switch to .

2. Place electrodes H (Z) and S (Y) at least 30m (98 ft) apart so that there is no
interference between them.

o8
O §
S(Y)
—I-L ‘Q =
> 30 m (98 ft) > 30 m (98 ft) oF
«—— 0
RE1 REZ RES R
- 7

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc).

3. Connect the cables to terminals H (Z) and S (Y), connect a cable between
terminal E (X) and the earth electrode under test, then connect the clamp to
terminal ES (Xv). The device recognizes it automatically.

4. Clamp to the path of the earth electrode to be checked, then connect a lead
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from the current clamp to this same point [connection to terminal ES (XV)].
Take care not to place the cable of electrode H (Z) too close to the current
clamp in order to avoid any transmission of the AC signal to the clamp (espe-
cially when using an MN82 clamp).

Start the measurement by pressing the START/STOP button.

o)) M}
a7

R (
o LD 1 (g
@ US'ES RSEL= RE1

-
(M ]
N’
DO
-
3
<

® H-E

-
Un
>

,,-
g"-'
=
(M ]
D
3

START/STOP

You can now move the clamp and its lead to measure the other earth resist-
ances, R_,, R,, etc.

To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

Ree Useer lhe R-ACt (Rp,q6), U-Act (U, - and its frequency), I-Act (I and its
frequency).

H-E’

To measure the resistances of auxiliary electrodes H (Z) and S (Y), or if the resis-
tance of the electrodes is too large (see § 10.1), start the measurement with a long
press of the START/STOP button.

Re. R, R, Ug g will be displayed.
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5.6 Soil Resistivity Measurements (P Position)

To measure the resistivity of the soil, two measurement methods are possible:
Wenner and Schlumberger

The difference between the two methods lies in the positioning of the electrodes.
By default, the device selects the Wenner method. The Schlumberger method,
which allows you to move only 2 measurement electrodes rather than 3, is better
suited for measuring soil resistivity at multiple depths.

The soil resistivity measurement with different distances d, and therefore in dif-
ferent layers (in depth) of the soil, can be used to establish resistivity profiles of
the soil in question, which can be useful for geological analysis, the exploration
of deposits, hydrological studies, etc., and to determine the location of an earth

electrode.

5.6.1

Advantages and Disadvantages of Wenner and Schlumberger

Schlumberger

Wenner

Advantage

Disadvantage

Advantage

Disadvantage

Need to move the two
potential electrodes ES
(Xv) and S (Y) only for
most readings. This can
significantly decrease the
time required to acquire
a sounding

All four electrodes, the two
current E (X) and H (2) and
the two potential ES (Xv)
and S (Y) must be moved
equally to acquire each
reading.

Because the potential
electrode spacing is
small compared to

the current electrode
soakings, higher meter
sensitivity is required.

Potential electrode
spacing increases

as current electrode
spacing increases. Less
sensitive meters may
be used.

Because the potential
electrodes remain in
fixed locations, the ef-
fects of the near surface
lateral variations in
resistivity are reduced.

Because all electrodes

are moved for each
reading, this method can
be more susceptible to
near-surface, lateral, and
variations in resistivity.
These near surface lateral
variations could potentially
be misinterpreted in terms
of depth variations in
resistivity.

In general, interpretations
based on DC soundings
will be limited to simple,
horizontal; layered
structures

In general, interpretations
based on DC soundings
will be limited to simple,
horizontal; layered
structures.

Source: DC Resistivity - T. Boyd
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5.6.2 Changing the Measurement Method

1. Set the switch to @

2. Press the Hz/opTIONS button. "AUTO" will blink.
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3. Press the Hz/oPTIONS button again. "W" will blink.
4. Press the » button to change to the Schlumberger method.

5. To confirm and exit, press the Hz/oPTIONS button twice.
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Hz/opTIONS ® conne Ao ’ ® conne Ao Hz/opTIONS

To switch back to the Wenner method, simply repeat this procedure.

The last measurement method selected (Wenner or Schlumberger) is stored in
memory when the device is switched off.

5.6.3 Programming the Distance for Electrode Placement

The distance can be programmed before or after the measurement. If it is not
programmed, only the value of Ry ¢ will be displayed, since the value of p remains
indeterminate.

1. Set the switch to @

2. Press the 2nd button, then the DISTANCE button. The "hundredths" will blink.
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3. To modify the hundredths (of meters or feet), press the A button until the
desired digit is displayed (0-9).

4. To select and modify the tens, press the » button and then the A button until
the desired digit is displayed (0-9).

5. To select and modify the units and tenths of a unit, press the » button and
then the A button until the desired digits are displayed (0.0-9.9).

6. To terminate the programming of distance, press the 2nd button and then the
DISTANCE button.

In the case of the Schlumberger method, it is also necessary to program distance
A. This is done in the same way as for distance d.

5.6.4 Wenner Method

1. Set the switch to @

2. Place the 4 earth electrodes on a straight line, at a distance d from one an-
other and at a depth p < 1/3 d. Distance d must be between 2 and 30m.

3. Connect the cables to the electrodes, then to terminals H (Z), S (Y), ES (Xv),
and E (X) in sequence.

4. Program the distance into the instrument as described in § 5.6.3.

Oﬁ]
O&
H S ES E-—T

A 4
[PEEPE PR PR R I
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In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).

5. Start the measurement by pressing the START/STOP button.
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Py = 2.1.d.Recs

To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:
Pw Rgesr d, U I, e U-Act (Ug s and its frequency, U, . and its frequency).

S-ES’ 'H-E’
To measure the resistances of the auxiliary electrodes H (Z), S (Y), ES (Xv) and E

(X), or if the resistance of the electrodes is too high (see § 10.1), start the measure-
ment by a long press of the START/STOP button.

R.:and R, then R, ., and R, ¢ will be displayed.
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5.6.5 Schlumberger Method

1.
2.

Set the switch to @ .

Place electrodes S (Y) and ES (Xv) at a distance A apart, then place elec-
trodes H (Z) and E (X) in the same straight line, at a distance d measured from
the midpoint of distance A. Distance d must be between 2 and 30m.

Drive the electrodes to a depth p of not more than 1/3 of d.

Connect the cables to the electrodes, then to terminals H (Z), S (Y), ES (Xv),
and E (X).

Program the distance into the instrument as described in § 5.6.3.

H

Oz
O (%Y

oF
J o
H (2) S (Y) ES (Xv) E (X)
T v

PR G
«—d—>|¢e——d— >

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).

6.

Start the measurement by pressing the START/STOP button.
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To display the measurement parameters, press DISPLAY several times.

The device displays the following parameters:

Pg Reesr O Ugper Iy er U-Act (Ug . and its frequency, U, . and its frequency).

To measure the resistances of the auxiliary electrodes H (Z), S (Y), ES (Xv),
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and E (X), or if the resistance of the electrodes is too high (see § 10.1), start the
measurement by a long press of the START/STOP button.

R..and R,,, then R, .  and R, ¢ will be displayed.
o) [} o) M}
® P, 1T ® P, 1T
o LCLCX o LKL
e M2 TR
N » - kQ L3 - kQ
>2s @é ] @- ]
i [ ; [
@ ® H AUTO “ ® AUTO K@
START/STOP DISPLAY

5.7 Potential Measurement (V pot)

The earth potential measurement is similar to the 3-pole earth measurement, but
rather than measuring the resistance, the device measures the potential U, ., on
auxiliary electrode S (Y) at different distances d from earth electrode E (X). The
relative potential U, ., is the ratio between the voltage U, . measured on electrode
S (Y) and the total applied voltage U, ; it is therefore a number between 0 and 1.
After entering a set of values for different distances d, you can determine the varia-
tion of the potential around an earth.

1. Set the switch to V pot.

2. Place electrode H (Z) at a distance A from the earth and electrode S (Y) at a
distance d1 from the earth.

A
Q
N~
A

A
Q
ai

y

e A

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.). Connect the cables to terminals H
(Z) and S (Y) and connect terminal E (Z) to the earth.
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3. Press the 2nd button, then the DISTANCE button. The "hundredths" will blink.
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4. To modify the hundredths (of meters or feet), press the A button until the
desired digit is displayed (0-9).

5. To select and modify the tens, press the » button and then the A button until
the desired digit is displayed (0-9).

6. To select and modify the units and tenths of a unit, press the » button and
then the A button until the desired digits are displayed (0.0-9.9).

7. To terminate the programming of distance, press the 2nd button and then the
DISTANCE button.

NOTE: To program distance d, perform the preceding steps.
8. Start the measurement by pressing the START/STOP button.
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9. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

R and its frequency, I-Act (I and its frequency).

LOOP IES
10. Move electrode S (Y) to distance d2, then reprogram the value of d and make
another measurement. Repeat for d3, d4, and d5.

11. Record all of the measurements in order to be able to determine the variation
of the earth potential between points H (Z) and E (X).
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5.8 Earth/Ground Measurements with Two Clamps

This is a quick way to measure the value of the earth.

NOTE: Any error that occurs will be on the high side without the need of
auxiliary electrodes.

The current clamp connected to terminal H (Z) applies a voltage to the circuit to be
measured. The value of the resulting current is determined by the impedance of
the circuit to be measured. The current flowing in the loop is measured using the
clamp connected to terminal ES (Xv). The device then calculates loop resistance

R oo from these quantities.

NOTE: Use only SR182 or MN82 current clamps, which are specially designed
to operate with the Model 6472.

1. Set the switchto |_ << J.

2. Connect a clamp to terminal H (Z) and clamp it to a point down stream from
the rod under test that is a serial path to the earth.

3. Connect the other clamp to terminal ES (Xv) and clamp it to the rod or elec-
trode system to be measured.

H

©g
o4&
ES
—C w
Re O&

Y/

Observe the following minimum distances between the two clamps in order to
avoid direct electromagnetic influences between the transmitting clamp and the
receiving clamp:

Value measured Minimum separation
(®) MN82 SR182
0to1 0.1m (4") om (0")
1105 0.4m (1' 04") 0.1m (4")
5t0 10 0.5m (1' 08") 0.2m (8")
10 to 50 0.7m (2' 04") 0.3m (1)
50 to 100 0.9m (3') 0.5m (1' 08")
100 to 500 1.2m (4" 0.5m (1' 08")
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1. Start the measurement by pressing the START/STOP button.

In the case of the diagram below, the earth impedance measured is equal to:

Roor= Re + (R, /1R, /I Ry,)
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NOTE: In the AUTO mode, the measurement frequency is 1611Hz. To make
an earth measurement that is free of inductive effects, you must change to
MANUAL mode and choose a lower measurement frequency (see §6.2).
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CHAPTER 6

MANUAL MODE

All of the measurement functions described in § 5 (AUTO mode) can be performed
in MANUAL mode if necessary.

To access MANUAL mode:

* Press the HzZ/OPTIONS button once. The Hz/OPTIONS symbol appears
and the AUTO indicator blinks.

« Use the » button to switch from AUTO to MANUAL or, when in 3-Pole or
4-Pole earth measurement, to SWEEP (see § 6.9).

*  When the testeris in MANUAL mode you can press Hz/OPTIONS repeatedly
to see various parameters that can be set, depending on the measurement
function selected.

When a measurement is performed by a short or long press on the START/STOP
button (the circular arrows ‘1 ) on the display will rotate), the measurement can be
stopped by a second press of this button.

Whenever a new measurement function is selected, the device automatically
changes back to AUTO mode.

6.1 Switching the Test Voltage
Available in all functions except mQ and 2 Clamp.
If necessary, the test voltages can be switched to either 16 or 32V as follows:

* Press the HzZ/OPTIONS button, then press it again to make the output volt-
age (Uout) blink.

* Use the » button to switch to 16 or 32V, then press Hz/OPTIONS again.

This setting is retained when the unit is turned off.
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6.2 Measurement Frequency Selection

If there are signals with a frequency that could interfere with the chosen test fre-
quency, the NOISE symbol will appear.

While in MANUAL mode, change the frequency by pressing the Hz/OPTIONS
button until the frequency flashes.

Press the » button to choose the following frequencies:
« USr, 55,92, 110, 119, 128 Hz (128 Hz is default).
» 128, 1367, 1611, 1758 Hz for the 2-clamps function (1611 Hz is default).

To change the user frequency (USr), press the A ¥ buttons (A V¥ raises the value,
and 2" + A ¥ lowers it).

Table of possible USr frequencies (91 values from 41 to 5078Hz):

41 43 46 49 50 55 60 61 64 67 69 73 79 82 85 92

98 (101 | 110 | 119 | 122 | 128 | 134 | 137 | 146 | 159 | 165 | 171 | 183 | 195 | 201 | 220
238 | 244 | 256 | 269 | 275 | 293 | 317 | 330 | 342 | 366 | 391 | 403 | 439 | 476 | 488 | 513
537 | 549 | 586 | 635 | 659 | 684 | 732 [ 781 | 806 | 879 | 952 | 977 | 1025|1074 | 1099 | 1172
1270|1318 | 1367 | 1465 | 1563 | 1611 | 1758 | 1904 | 1953 | 2051 | 2148 | 2197 | 2344 | 2539 | 2637 | 2734
2930 | 3125 | 3223 | 3516 | 3809 | 3906 | 4102 | 4297 | 4395 | 4688 | 5078

There are two user frequencies: one for resistivity and one for earth and soil po-
tential measurements. These two values remain in memory even after the device
is switched off.

For soil resistivity measurements, the user frequency is limited to 128 Hz.

6.3 Manual Settings for mQ Measurements

Pressing Hz/OPTIONS in MANUAL mode allows the following parameters to be
changed using the » button:

« Terminal symbols H and E blink > H S ES E blink (4-Pole measurement)
* POS on H and DC+ blinks = neg on H and DC- (reversal of polarity at terminal H)

In MANUAL mode the tester does not reverse polarity automatically during the
measurement; however, the polarity can be reversed during the measurement by
pressing the Hz/OPTIONS button.
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6.3.1 Continuity Test
The 2-wire mQ measurement gives a quick measurement result, accompanied by
an audible beep, during a continuity check.

The display is in the sensitivity range (0.5Q to 1.99kQ) and the terminal check is
limited to terminal H (Z) (a cable must be connected to it), making it possible to
start the measurement with an open circuit.

For a continuity check, the following settings are mandatory:

* The 2-wire mQ measurement function must be selected.
* The device must be in manual mode.

* The alarm function must be active (On).

e The alarm threshold must be low (<).

* The buzzer must be activated (bEEP On).

6.4 3-Pole Earth/Ground Measurement & Coupling

6.4.1 3-Pole Earth/Ground Measurements

Pressing on Hz/OPTIONS in MANUAL mode allows the following parameters to
be changed using the » button:

* EARTH blinks - Earth Coupling Measurement
* 128 Hz blinks - Test Frequency Measurement
« Test voltage blinks > Test Voltage Selection

6.4.2 Earth/Ground Coupling Measurements

This measurement calls for making and storing 3 intermediate measurements (at
the same frequency). It is available only in MANUAL mode.

Connection diagram:

Measurement #3
Earth 1 Earth 2

Measurement #1

R,

Measurement #2

R,
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Press Hz/OPTIONS and use the » button to switch from EARTH to EARTH COU-
PLING. Proceed as follows:

If you want to eliminate the resistance of the measurement leads, you can
use lead compensation (2nd + START) before starting the actual coupling
measurement (see § 5.2.1).

Turn the rotary switch to 3-Pole.
Select a test frequency and a test voltage (if desired).

The screen displays EARTH COUPLING 1. Make a 3-pole earth measure-
ment on the first earth system (measurement of R, in the connection dia-
gram on previous page).

Stop the measurement by pressing the START/STOP button. The MEM
symbol flashes to indicate that this result must be recorded in memory.
Press the MEM button twice. To save to another location, refer to §7.

The screen now displays EARTH COUPLING 2. Make a 3-pole earth mea-
surement on the second earth system (measurement of R,). For this second
measurement, leave the H (Z) and S (Y) electrodes in the same positions as
for the first measurement.

Store this result in the same memory location as before by pressing the
MEM button twice.

The screen now displays the message EARTH COUPLING 3. Disconnect
terminal S (Y) and make a 2-wire resistance measurement with terminal H
(Z) connected to earth 1 and terminal E (X) to earth 2.

Record this result by pressing the MEM button twice.
EARTH COUPLING 4 and the results of the measurements are displayed.

The calculation is based on the following formulas:

R.= (R, +R,—R,)/2
C1 = RC/R1 and C2 = RC/R2 RA = R1 - RC
Rb = Rz - Rc

To display all of the measurement parameters, press the MR button.

To scroll through all of the measurements, use the » and A buttons.
i; then i; i] i] i] x4
| 4 4 A

2nd MR
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Press DISPLAY several times to display the following parameters:

EARTH COUPLING 1 R, , Uy, and frequency, U, I, ., U-In (U, . and frequency)
R, and R if long press of START/STOP
EARTH COUPLING 2 R, U,,; and frequency, U, I,, ., U-In (U, . and frequency)
R, and R if long press of START/STOP
EARTH COUPLING 3 R,,. U, and frequency, |, ., U-In (U, and frequency).
EARTH COUPLING 4 R.. C,, C, R, R, U, and its frequency.

6.5 4-Pole Earth/Ground Measurements
Pressing the Hz/OPTIONS button allows the following parameters to be changed
using the » button:

* 128Hz blinks - Change the test frequency

» Test voltage blinks - Switch between 16 and 32V

6.6 Soil Resistivity Measurements
Pressing the Hz/OPTIONS button allows the following parameters to be changed
using the » button:

*  Pw blinks (Wenner method) - Switch to Ps (Schlumberger method)

e 128Hz blinks - Change the test frequency

« Test voltage blinks - Switch between 16 and 32V

6.7 Earth/Ground Potential Measurements

Pressing the HzZ/OPTIONS button allows the following parameters to be changed
using the » button:

*  128Hz blinks - Change the test frequency

« Test voltage blinks > Switch between 16 and 32V

6.8 Measurements with Two Clamps

Pressing the Hz/OPTIONS button allows the following parameters to be changed
using the » button:

*  1611Hz blinks - Change the test frequency
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6.9 SWEEP Mode

For the 3- or 4-pole earth measurements (without clamp, selective with clamp,
or with the GroundFlex®), it is possible to select the frequency sweep mode
(SWEEP).

Press the Hz/OPTIONS button, then the » button. The device then displays the
first free memory location (OBJ:TEST) in which to store a series of measurements
with a series of preset frequencies.

The device makes a measurement at each of the following frequencies:
[ 41 | 64 | 92 | 128 | 256 | 513 [1025]1465]2051] 2539|3125 3516]4102] 4687 | 5078|

These SWEEP frequencies are factory defaults, preset in the memory. The user
can change them by configuring the tester using DataView® software.

6.10 Smoothing

In the manual mode, you can activate or deactivate the smoothing of the measure-
ment results by pressing the 2nd + DISPLAY (SMOOTH) buttons. This smoothing
consists in displaying an exponential mean value, a significant help with highly
fluctuating values.
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CHAPTER 7

MEMORY FUNCTION

The device has a total of 512 memory locations. Each of these locations is defined
by an object number (OBJ) from 01 to 99 and by a TEST number from 01 to 99.

For 3- and 4-pole earth measurements, and for measurements using the Ground-
Flex®, the sweep mode (SWEEP) can record several measurement results at the
same memory location, with the frequency as third addressing criterion.

During soil potential or resistivity measurements (Wenner or Schlumberger meth-
ods), several measurement results are recorded at the same memory location,
with the distance between electrodes as the third addressing criterion.

For earth coupling measurements (EARTH COUPLING 1, 2, 3, 4), the four mea-
surements provide the third addressing criterion for the same memory location.

None of the other measurements has an additional addressing criterion, so each
occupies only one memory address.

Since each measurement is dated, you must set the date and time of the device
before any storage in memory (see § 4.2).

7.1 Saving Measurements into Memory
Measurement results can be saved by performing the following:

* Press the MEM button. The tester will automatically suggest the next free
memory location (Fr £ £ message).

« Press the MEM button a second time to save to the OBJ/TEST location.
» If you decide not to save your results, press DISPLAY to exit MEM mode.
* To change the OBJ and TEST location, use the » and A V¥ buttons.

NOTE: If a memory location is already occupied, the message ol L will be dis-
played. Pressing the MEM button will overwrite the measurement record.

When you change to SWEEP mode (§ 6.9), the device automatically activates the
MEM mode. It offers a memory location before starting the measurement. All of the
results obtained will be stored at this location at the end of the measurement.
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For soil resistivity and potential measurements, if several measurements are made
with different distances d, you can store them under the same OBJ:TEST number,
with the distance as third addressing criterion.

It will be possible to overwrite values already stored with new ones having the
same distance d, or even to add new results having other values for the distance d
provided that all of the other measurement parameters are identical.

7.2 Recalling Measurements from Memory

To recall saved measurements, perform the following:
+ Select a measurement function, then press the 2" and MR buttons.
* Usethe » and A V¥ buttons to choose the OBJ and TEST numbers.
* Press the DISPLAY button to display the time (tiME) and date (dAtE).
* Press DISPLAY again to display the measurement and its parameters.
* Press the MR button again to exit the recall mode.

If there are saved results in SWEEP mode, the frequency will be displayed as a
third address parameter below the OBJ:TEST number selected. Use the » and
A V buttons to select different frequencies.

The SET-UP function lets you read all memory addresses one after the other
independently of which measurement function is chosen.

Any measurement stored in the tester can be retrieved individually using Data-
View® software (see § 8).

7.3 Erasing Measurements from Memory

There are two ways to erase measurements - complete and selective.

7.3.1 Erasing All Measurements
« Set the switch to SET-UP.

* Push once on the MEM button to display the number of free and available
records.

¢ Push a second time on the MEM button.
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+ The display will show “dEL ALL". Change the blinking NO to YES with the A
button, then perform a long press (>2s) on the MEM button.

A WARNING: This will delete ALL saved records.

» To exit without erasing, perform a short press on the MEM button.

7.3.2 Erasing Selective Measurements

+ Set the switch to SET-UP.

+ Hold down the 2" button, then press the MR button.

* Select the desired measurement using the » and A ¥ buttons.

» The display will show “dEL". Change the blinking NO to YES with the A button,
then perform a long press (>2s) on the MEM button.

» To exit without erasing, perform a short press on the MEM button.
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CHAPTER 8

DATAVIEW® SOFTWARE

8.1 Introduction

The DataView® graphing and analysis program is a full function Windows® based
application software package.

It provides you the ability to configure and run any test or recording from the com-
puter as you can from the instrument itself.

Additionally, it enhances the information captured for snapshots as it captures all
the information to display and report data in real time.

DataView® includes several pre-defined templates for displaying and printing re-
ports, as well as the ability to totally customize the reports to meet your exact
needs.

This chapter will give you the information you need to know to use this program.
More extensive information on specific functions available in DataView® is avail-
able in the online help system included with the software.

DataView® software is a copyright of Chauvin Arnoux®, Inc. d.b.a. AEMC?® Instruments

8.2 Features

DataView® has a simple, easy-to-use interface for configuring and running tests,
as well as printing reports of the test results. There are many features that are
available through this program. A few of the most popular are listed below.

Key Features:
¢ Runs tests from your computer with a simple click and execute process
¢ Views and captures data in real time
¢ Retrieves data from the instrument’s memory
¢ Plots graphs of recorded information that has been downloaded
e Presents reports, including your analysis in the comments section
e Stores a library of SET-UP's on your PC for different applications
¢ Provides consistency in testing, regardless of who performs the test

A NOTE: For additional help on using the software, use DataView®’s “Help”
Menu, which is located on the menu bar.
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8.3 Installing DataView®

INSTALL DATAVIEW® BEFORE CONNECTING THE INSTRUMENT TO THE
COMPUTER.

Minimum Computer Requirements:
* Windows XP / Windows Vista & Windows 7 (32/64 bit)

+ 256MB of RAM for Windows XP
1GB of RAM for Windows Vista & Windows 7 (32 bit)
2GB or RAM for Windows Vista & Windows 7 (64 bit)

* 80MB of hard disk space (200MB recommended)

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

NOTE: When installing, the user must have Administrative access rights

during the installation. The users access rights can be changed after the
installation is complete.

DataView® must be reinstalled for each user in a multi-user system.

1. Insert the DataView® CD into your CD-ROM drive. If auto-run is enabled, the
Setup program will start automatically. If auto-run is not enabled, select Run
from the Start menu and type in D:\SETUP (if your CD-ROM drive is drive D.
If this is not the case, substitute the appropriate drive letter).

/,\ NOTE: If installing onto a Vista based computer, select Allow to proceed.

2. A Set-up window, similar to the one below, will appear.

&Selup &‘

Francais
Espafiol

Exit

Select an option fiom the list below; then select the
Install button.

Options Desciiption

Installs the English version of Datatiew onta this computer
This wersion of D ataView supports the following instruments:

Metaliewer

Software Lpdates Ground Tester [Model 470 and £472)
Firmysare Uparades Megohmmeter (Model 1060, 5060 and 5070
Documents Micra-Ohmmeter [Model 5240 and B250]

Power Meter [Model 8220)

Paower Quality Logger (Model POL100 and PULT20)
PowerPad (Model 3345 and 2345.8)

PowerPad | (Model 8335)

PawerPad.Jr [Model 8230]

Sentinel O ata Logger

Simple Logger I

Figure 8-1
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There are several different options to choose from. Some options™®) require an
internet connection.

DataView, Version x.xx.xxxx - Installs DataView® onto the PC.

*Adobe Reader - Links to the Adobe® website to download the most recent
version of Adobe® Reader to the computer. Adobe® Reader is required for
viewing PDF documents supplied with DataView® that are accessible from
the Help menu.

MetaViewer - The MetaViewer utility program allows a user to view and
print .dmf or .emf files generated by DataView® without having DataView®
software installed.

*Software Updates - Links to the AEMC® Software Update website to check
for new software version releases.

*Firmware Upgrades - Links to the AEMC® Firmware Upgrade website to
check for new firmware version releases.

Documents - Shows a list of instrument related documents that you can
view. Adobe® Reader is required for viewing PDF documents supplied with
DataView?®.

DataView, Version x.xx.xxxx option should be selected by default. Select
the desired language and then click on Install.

The Installation Wizard window will appear. Click Next.
To proceed, accept the terms of the license agreement and click Next.

In the Customer Information window, enter a Name and Company, then
click Next.

In the Setup Type window that appears, select the “Complete” radio button
option, then click Next.

In the Select Features window that appears, select the instrument’s control
panel that you want to install, then click Next.

NOTE: The PDF-XChange option must be selected to be able to generate
PDF reports from within DataView®.
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Figure 8-2
9. Inthe Ready to Install the Program window, click on Install.

10. If the feature selected for installation requires the use of a USB port, a warning
box will appear, similar to Figure 8-3. Click OK.

DataWies - InetaliShiald Wieard

i i it ponaesct, e AEMIC LESH Instrumesnt (o0 Cabie) untll after Hhe instaliston of the drivers snd the Deste\iess sof tware has Finished.

1F the AEMC LS Irsirument {or esbie) & oonpected bo the computer mow then disconpect | from the computer Before procesdng.

Figure 8-3

A NOTE: The installation of the drivers may take a few moments. Windows may
even indicate that it is not responding, however it is running. Please wait for
it to finish.

11. When the drivers are finished installing, the Installation Successful dialog
box will appear. Click on OK.

12. Next, the Installation Wizard Complete window will appear. Click on Fin-
ish.

13. A Question dialog box appears next. Click Yes to read the procedure for con-
necting the instrument to the USB port on the computer.

A NOTE: The Set-up window remains open. You may now select another option
to download (e.g. Adobe® Reader), or close the window.
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14. Restart your computer, then connect the instrument to the USB port on the
computer.

15. Once connected, the Found New Hardware dialog box will appear. Windows
will complete the driver installation process automatically.

Shortcuts for DataView® and each instrument control panel selected during the
installation process have been added to your desktop.

NOTE: If you connected your instrument to the computer before installing
the software and drivers, you may need to use the Add/Remove Hardware
utility to remove the instrument driver before repeating the process.

8.4 Connecting the Model 6472 to your Computer

The Model 6472 is supplied with an optically isolated USB interface cable required
for connecting the instrument to the computer. This cable (Cat. #2135.41) is
equipped with a USB type A on one end, and an optical connector on the other
end.

To connect the Model 6472 to your computer:

1. Connect the optical connector end of the cable to the serial port on the
front panel of the Model 6472 (see Figure 2-1, Item #4).

2. Connect the USB type A end of the cable, to an available USB port on
your computer.

You are now ready to use the DataView® software with the 6472.
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8.5 Opening the Ground Tester Control Panel

To open the Control Panel, double-click the Ground Tester Icon that was created
during installation, located on the desktop.

O tes CTREOT D i AR

T B REw LA

P |

Figure 8-4

The Ground Tester Control Panel opens and displays the following:
* A shortcut toolbar
» Atoolbar with the mode selection and start/stop buttons.

* The instrument's status window (on the left-hand side):
- Recorded data from the instrument
- Real-time data
- Connection status
- The communications port and speed of the connection
- The model number, serial number, and firmware version
- Date and time from the clock
- Battery status

» Configuration window that shows all of the parameters available for modifi-
cation. This window defaults to the instrument mode that is selected.

* Real-time Measurement window that shows the measurement of each test
performed in real-time (available only after a test has been performed)

If the indicated items are not shown on the screen, select Restore Default Layout
from the Window menu.
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8.5.1 Establishing Communication to the Instrument

If the instrument is turned ON at the time the Ground Tester Control Panel is
opened, a communication link will happen automatically.

If the instrument is turned OFF at the time the Control Panel is opened, establish a
communication link by going to Instrument > Connect in the main menu.

+ The Communication dialog box will appear. Make sure that the communica-
tion port displayed in the dialog box matches the port that the serial cable is
plugged into.

Cormenare shora, Port . i LISH 10 il 5
Ginrramrsceon Flobs | 8600 =] T
s Addess |1 Hel
Figure 8-5

* Once the proper communication parameters have been specified, click OK.

NOTE: The connection status can be seen in the lower right-hand corner of
the Control Panel and in the Instrument window under status.

8.6 Configuring the Instrument

To configure the instrument, perform the following steps.
1. Double-click the Ground Tester icon on your desktop.

2. Go to Instrument > Configure from the main menu of the Control Panel.

NOTE: If a connection has not been previously established, the Communi-
cation dialog box will appear (see Fig. 8-5).

3. Once identification is complete, a Configuration dialog window will appear
(if not already open).

The descriptions of the features below appear on several Configuration dialog
boxes, depending on the type of test selected.

* Load from File: Retrieves stored configurations to be used in programming
the instrument.

» Save to File: Saves the current configuration. This file will reside on the
computer’s disk drive. Saving different configuration setups can be useful
for future functions and tests.

* Set Instrument Clock: Updates the clock to the PC clock.

e Buzzer: When selected, buzzer is ON.
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e Alarm: When selected, alarm is ON.

* Drop-down Indicators: Indicates the configuration available for each mea-
surement range.

A NOTE: To set the Terminal Label markings (e.g. H, S, ES, E or Z, Y, Xv, X),
Measurement units and Rho units, go to Tools > Options.

8.6.1 DC Continuity Test

When DC Continuity is selected from the tool bar, you can:
» Select a 2- or 4-Wire test.
» Select a test current (positive, negative or Auto ).
» Enter and activate an alarm from 1 to 999Q (2-Wire only), if desired.

For very low resistance measurement, a lead compensation value (see § 5.2.1)
may be entered using the Change button.

Input noise status at the input of the meter is always displayed.

« Configuration

ToodFiontis | [2wre < I[+/-fut Gunert
Save [ofds
Giet Iisument Clock
[T DL 24 e ludo
Disabilad Enabled # |
Ensble alarn [« =][Z o
Lewad Comperantinns [ miickms T [haege
b it ]
VZdsy
Figure 8-6
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8.6.2 3-Pole Ground Resistance Test

When 3-Pole Ground Resistance is selected from the tool bar, you can select:

With or without Auxiliary Rod Resistance.

Test voltage of 16 or 32VAc.

Distance "d" from terminal X to terminal .
Distance "a" from terminal X to terminal Z.

Auto frequency - selects the optimum frequency (from 41 to 5078Hz), usu-
ally 128Hz, or select manually from the drop-down frequency list.

Selecting a sweep frequency test from the drop-down list will enable the sweep
table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.

..t" Configuration

Load From File |W’ith0ut Aux. Fod Resistance j|Auto Frequency ﬂ

Save ToFile |32 Test Valtage Limit |

Set Instrument Clock

Buzzer FFale

Disabled Enabled ©*

d=|-- Meters
A=|--- Meters

Input Moize
Show Z Input lﬁ| Show ' Input
W = O

Setup Sweep T able

Figure 8-7
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8.6.3 4-Pole Ground Resistance

When 4-Pole Test Resistivity is selected from the tool bar, you can select:

With or without Auxiliary Rod Resistance.
Test voltage 16 or 32VAc.

Auto frequency - selects the optimum frequency (from 41 to 5078Hz), usu-
ally 128Hz, or select manually from the drop-down frequency list.

Selecting a sweep frequency test from the drop-down list will enable the sweep
table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.

o Configuration r-_lralf'fl

L Finas Vil | Foviband frum. Hod Homtarcs = [ st Freumry -]
Gave Ta Fil |22 Temat Vol Lant -]
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.
[]
'lrin Jpom Jpen Jrs
Inpust Heise
Show Z Irput | Show Y Ipwst (7 |
Sehp Sweep Table WiHva i
Figure 8-8
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8.6.4 3-Pole Plus Clamp Resistance

Useful for testing multiple points without having to move the current and potential
electrodes.

This option is only available when there is a current probe connected to the Xv
terminal. The following configuration options are available:

»  With or without Auxiliary Rod Resistance.
» Test voltage 16 or 32VAc.

» Auto frequency - select the optimum frequency (from 41 to 5078Hz), usually
128Hz, or select manually from the drop-down frequency list.

Current (Z) and potential electrodes (Y) are installed as in a fall-of-potential test.
Current probe and lead are both connected at the test point. Multiple test points
can be measured by moving the probe with its lead to a new location, but not mov-
ing the current and potential electrodes.

The instrument should be strategically positioned so that the leads will not be too
short to perform all the measurements.

The Input Noise option allows the viewing of noise for Z or Y inputs.

£ Configuration
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Figure 8-9
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8.6.5 4-Pole Soil Resistivity @

When 4-Pole Test Resistivity is selected from the tool bar, you can select:
«  With or without Auxiliary Rod Resistance.
« Test voltage 16 or 32VAc.

» Auto frequency - selects the optimum frequency (from 41 to 128Hz), usually
128Hz, or select manually from the drop-down frequency list.

» Test Method - Wenner or Schlumberger.

» Distances - the distance “d” (for Wenner test method) or “d” and “a” (for
Schlumberger test method), between the test electrodes, needs to be en-
tered for resistivity calculation to read out directly in Rho.

Selecting a sweep frequency test from the drop-down list will bring you to the
sweep table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.
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8.6.6 Ground Potential

When Ground Potential is selected from the tool bar, you can select:
*  With or without Auxiliary Rod Resistance.

+ Test voltage 16 or 32VAcC.

+ Distance "d" from terminal X to terminal Y.

+ Distance "a" from terminal X to terminal Z.

« Auto frequency - selects the optimum frequency (from 41 to 5078Hz), usually
128Hz, or select manually from the drop-down frequency list.

Selecting a sweep frequency test from the drop-down list will bring you to the
sweep table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.
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8.6.7 Ground Loop R

This mode can only be selected when there are current probes connected to the
Z and Xv terminals. When Ground Loop R is selected from the tool bar, you can
select:

» Auto frequency - selects the optimum frequency (from 1367 to 1758Hz),
usually 1367Hz, or select manually from the drop-down frequency list.
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Figure 8-12
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GroundFlex"|
8.6.8 GroundFlex®

NOTE: This option is only available when there is a GroundFlex® Adapter
connected to the 6472.

When GroundFlex® is selected from the tool bar, you can select:

«  With or without Auxiliary Rod Resistance.
» Test voltage 16 or 32VAcC.

» Auto frequency - selects the optimum frequency (from 41 to 128Hz), usually
128Hz, or select manually from the drop-down frequency list.

*  Number of turns of the GroundFlex® around the connector.

* Aninput sensitivity for the GroundFlex®. Choice is 0.1, 1, or 10.0. If the value
is too high, the test will show "Overloaded inputs”. If that happens, try again
with a lower sensitivity.

* Input selection - Indicates which GroundFlex® is connected to the 6474.

Selecting a sweep frequency test from the drop-down list will bring you to the
sweep table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.
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8.7 Tools Menu

8.7.1 Tools > Options
» Set number display as scientific (1000 as "1E+3") or letters (1000 as "1k").
« Set Label Terminals to be "X", "Xv", "Y", "Z", or "E", "ES", "S", H".
* Set Measurement units to meter or feet
» Set Rho units to Ohm-meter or Ohm-centimeter

8.7.2 Tools > Colors

Sets colors for measurement channels.

8.7.3 Tools > Recover Data

Every time the directory of recorded data is displayed by the Ground Tester Control
Panel, a backup copy of all the data is saved to a file. Use this option to recover
previous data.

8.8 Starting a Test

Press the START button to begin a test. Some tests configurations are automatic
and end when the data is stable. Others, generally when there is a manual fre-
quency, show a "Stop" button, which should be pressed when the data is available
on the screen and has stable values..

8.9 Downloading Data to Database

Select Recorded Data from the View menu to download the recorded data.

1. Select the data you want to download by clicking on the file name (see
Figure 8-14).

2. Select Create DataView Report. DataView® will be open with the newly
created report.

3. Alternatively, select Create Spreadsheet. Type a name for the download-
ed file. In the Save as type drop-down menu, select either .xIs (saves it
as an Excel spreadsheet file), or .csv (saves it as a comma delimited file),
then click Save.

4. Alternatively, select View. After the download is complete, a window will
appear with a graph of the data, and some viewing or channel options. In
that window, you can select Create DataView Report, Create Spread-
sheet, or Print.
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5. Also, from the Instrument tree view, expand the sections under Recorded
Data from the instrument, then click on a line that describes the re-
corded data. It will bring up a window with a graph of the data.

8.9.1 Recordings
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Figure 8-14

8.9.2 Session Properties

After creating a DataView® report, you can open the Session Properties dialog box
by selecting Edit > Edit Session Properties.
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Figure 8-15
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The Session Properties dialog allows you to specify Operator, Site and Custom
parameters that are to be saved with recorded data. These parameters are used
when generating reports.

The Operator and Site tabs allow you to maintain lists of operators and sites,
saving you time when specifying parameters for reports.

On the left of the Operator and Site tabs is the list of previously defined Operators
and Sites. On the right of the Operator and Site tabs is the individual parameters
that will be saved in an associated database. Only a single set of operator and site
fields are saved in the recording database.

The Custom tab contains a list of user defined parameters. Along side each user
defined parameter is a check box. Items that are checked will be added to an
associated database. Only a single set of Custom parameters can be maintained
(unlike the Operator and Site lists). The Custom tab allows you to specify any user
defined parameters (in addition to the comments field of the Site tab) that are to be
used in displaying a report.

NOTE: You can also set defaults for session properties within the Ground
Tester Control Panel by selecting File > Edit Session Properties.

8.10 Exporting the Report to a PDF File

» Select the data by clicking on the file name under Recorded Data from the in-
strument in the Instrument window on the left-hand side of the Control Panel.

* Click the Print button.

+ In the Print dialog box that appears, select PDF-XChange 3.0 from the drop-
down menu, then click OK.

* When the PDF is complete, the Save As dialog box will appear.
* Choose a location to save the file and click Save.

This completes the process of configuring, running, retrieving data, and printing a
report using DataView® with your Model 6472.

A In addition to the pre-designed report templates, DataView® allows you to
totally configure reports to your needs. Refer to the DataView® HELP file on
“Templates” to learn more about templates.
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CHAPTER 9

MAINTENANCE

9.1 Maintenance

A Please make sure that you have read and fully understand the WARNING
section on page 3.

» To avoid electrical shock, do not attempt to perform any servicing unless
you are qualified to do so.

» To avoid electrical shock and/or damage to the instrument, do not get water
or other foreign agents into the case.

e Turn the instrument OFF and disconnect the unit from all circuits before
opening the case.

» Use specified spare parts only.

9.2 Cleaning

A Disconnect the instrument from any source of electricity.

Use a soft cloth lightly moistened with soapy water. Wipe with a moist cloth and
then dry with a dry cloth. Never use alcohol, solvents or hydrocarbons.

9.3 Fuse Replacement
The unit is protected from overloads by two identical fuses:

* Fuse for terminal H (Z):

If this fuse is defective, the unit will no longer produce an output voltage, making it
impossible to perform resistance measurements.

To test this fuse, turn the switch to the mQ position (2-Wire), connect measurement
leads to terminals H (Z) and E (X) and start a measurement. If the unit refuses to
operate and the symbol for terminal H (Z) blinks, the fuse must be replaced.
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* Fuse for clamp terminal ES (Xv):

If this fuse is defective, the unit will no longer recognize a clamp that is connected
to terminal ES (Xv), making it impossible to perform a 4-Pole earth measurement
with a clamp or an earth measurement with 2 clamps.

To test this fuse, select the 4-Pole measurement function and connect a test clamp
to terminal ES (Xv). If a clamp symbol does not appear next to the symbol for ter-
minal ES (Xv) in the display, the fuse must be replaced.

A NOTE: For safety reasons this fuse must always be replaced by an identical
model: 0.63A F 250V 5x20mm 1.5KA (Cat. #2135.81)

Procedure for replacing fuses:

1. Disconnect the unit completely, turn the rotary switch to OFF, and close
the lid.

2. Loosen the four permanent screws at the bottom of the unit, but do not
remove them.

3. Open the lid and carefully turn the housing upside-down, making sure the
front panel does not fall out. Then carefully pull the front panel and the unit
all the way out of the housing.

4. The fuse for terminal H (Z) is accessible at the back of the unit (in the
corner near the terminal for the battery charger).

5. Ifonly the fuse for terminal H (Z) needs to be replaced, jump ahead to step
13. To replace the fuse for the clamp terminal ES (Xv), continue on.

6. Loosen the two screws on the lid of the battery case and remove the lid.

7. Pull the battery a short way out of the case without overstretching the con-
nection leads, and loosen the two screws at the bottom of the case. Then
put the battery back into the case.

8. Making sure the battery leads are not overstretched and that the battery
does not fall out, carefully lift off the back of the unit, turn it over and place
it next to the front panel with the electronic components.

9. The fuse for the clamp terminal ES (Xv) is now accessible on the printed
circuit board [in the corner near terminal E (X)]. When replacing the fuse,
avoid touching the circuitry or components.

10. Return the back of the unit to the front panel with the components, taking
care not to stretch the battery leads. Carefully lower the back of the unit
and make sure that it is aligned correctly (the four cylindrical holes on the
back must slip over the four mounting pins on the front panel). Also make
sure you do not pinch the battery leads or other wires or components.
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11. Pull the battery a short way out of the case without overstretching the
connection leads, and retighten the two screws at the bottom of the case.
Then put the battery back into the case.

12. Put the lid back onto the battery case and screw it shut.
13. Wipe off any dirt on the seal and housing rim.

14.Put the unit back into the housing and screw it into place.

9.4 Recharging the Battery

A NOTE: To make the best use of the battery and prolong its service life, ob-
serve the following rules.

» Use only the battery charger supplied with the unit; other chargers may be
hazardous!

* Recharge the battery only at temperatures between 32° and 104°F (0° and
+40°C).

» Observe the conditions of use and storage defined in the specifications.

Even an NiMH battery can be recharged only a limited number of times. This num-
ber, and thus the service life of the battery, is highly dependent on the following
factors:

» the operating conditions
» the recharging conditions

As the earth tester might go some time without use and the battery has a natural
tendency to run down, you should check the battery level at regular intervals. To do
this, turn on the unit and check the battery level indicator at the top of the
display. If there is only one bar in the symbol or if there are no bars at all, the bat-
tery should be recharged.

If the unit is not used for a long time, the battery might run down all the way. In
this case, recharging can take several hours. In addition, the unit might not work
properly at the start of recharging.

The capacity and lifetime of the battery may also be diminished. After about five
charging/discharging cycles the battery will recover its initial capacity.

To recharge the battery, plug the charging unit into the connector at the upper left
(connector @ in Fig. 2-1) and connect the charging unit to a 100 to 240VAC power
source (suitable for Europe and the U.S.). The frame of the battery symbol will
blink during charging. Charging goes faster when the tester is turned off. The bat-
tery voltage is shown on the large display next to Ubatt.
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At the middle and bottom of the display you will see one of the following mes-

sages:
bAtt CHrG Fast charging is active (normal state)
bAtt LOW Battery voltage is too low for a fast charge - charging at a lower current
bAtt Battery voltage is too high for a fast charge - charging at a lower current
bAtt HOt Battery is too warm for a fast charge (>40°C) - charging at a lower current
bAtt COLd Battery is too cold for a fast charge (<0°C) - charging at a lower current
bAtt FULL Battery is full - switch to trickle charging

The 6472 tester can also be recharged from a 12VDc car outlet with a special
charging unit.

A\

NOTE: In this case the low-potential of the vehicle’s 12V outlet is at the po-
tential of terminals E (X) and ES (Xv) of the ground tester. For safety reasons,
do not connect or use the unit if there is a possibility that voltages at E (X) or
ES (Xv) could exceed 32V.

9.5

Replacing the Battery

The battery in this unit is a special product with customized safety features and
protective devices. It should be replaced only by the same model. If a different
model is used, there is a danger of fire or explosion, leading to possible damage
or injury.

NOTE: For safety reasons, replace the battery with an identical model:
NiMH Custom Pack 9.6 V / 3.5 Ah (Cat. #2960.21)

Procedure for replacing the battery:

1.

Disconnect the unit completely, turn the rotary switch to OFF, and close
the lid.

Loosen the four permanent screws at the bottom of the unit, but do not
remove them.

Open the lid and carefully turn the housing upside-down, making sure the
front panel does not fall out. Then carefully pull the front panel and the unit
all the way out of the housing.

Loosen the two screws on the lid of the battery case and remove the lid.

5. Pull the battery a short way out of the case without overstretching the con-

nection leads, and loosen the two screws at the bottom of the case. Then
put the battery back into the case.
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10.

1.

12.
13.
14.
15.
16.

Making sure the battery leads are not overstretched and that the battery
does not fall out, carefully lift off the back of the unit, turn it over and
place it next to the front panel with the electronic components.

Press the clip off the plug, and pull out the plug with the four battery
leads (in the corner, near the terminal for the optical interface). Avoid
touching the circuitry or components.

Remove the old battery from the case and put in a new one. Run the
leads with the plug through the largest slot in the battery case.

Insert the battery plug (in the corner, near the terminal for the optical
interface). The two pins should point towards the clip. Avoid touching the
circuitry or components.

Return the back of the unit (with the new battery in the case) to the front
panel with the components, taking care not to stretch the battery leads.
Carefully lower the back of the unit and make sure that it is aligned
correctly (the four cylindrical holes on the back must slip over the four
mounting pins on the front panel). Also make sure you do not pinch the
battery leads or other wires or components.

Pull the battery a short way out of the case without overstretching the
connection leads, and retighten the two screws at the bottom of the
case. Then put the battery back into the case.

Put the lid back onto the battery case and screw it shut.
Wipe off any dirt on the seal and housing rim.

Put the unit back into the housing and screw it into place.
Fully charge the new battery in the unit before using it.

Reset the time and date.

A NOTE: If the instrument is not used for long periods of time (more than 6
months), it is recommended, in order to recover the initial capacity of the
battery, to make several charge-discharge cycles (3 to 5 times). Discharge
cycle (15 H) can be made with the instrument in MANUAL mode, DC 2-Pole
(2-Pole) resistance measurement and a short-circuit between H (Z) and E (X)

plugs.
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CHAPTER 10

TROUBLESHOOTING

10.1 Error Reporting

10.1.1 Electrode Resistance Too High

This can happen in a 3- or 4-pole earth measurement, a resistivity measurement,
or an earth potential measurement.

This message is displayed when the measurement is triggered by a short press of the
START/STOP button and the resistances of the auxiliary electrodes are too high.

The measurement must then be started by a long press on the START/STOP but-
ton. The device then measures the values of the electrodes and compensates for
them to display the correct result.

10.1.2 Out of Range

L L
~

<< o % The flashing > or < symbol indicates the measurement is
sin “/,»~>  out of range.

If both symbols flash together, it means that the accuracy
of the value displayed is outside of the instrument
- specification or is subject to large fluctuations. Activating
2 1+~ the smoothing function (SMOOTH) may correct this.
Press the 2nd button, then the SMOOTH button to activate
smoothing.

10.1.3 Misconnection

NV NIV N \1,  This flashing indicates that a terminal or a
~ ” ~ - ~ - ~ ” .
;@: -®)- ;@; ;@: current clamp needs to be either connect-
oy i U /1Y ed or disconnected. You must correct the

G : o N connections or the measurement will not
< % N QR - proceed. The flashing of terminal H may
7 \ N

also indicate that current |, _ is too low. The
flashing of terminal S may also indicate that
resistance Ry is too high. The flashing of
terminal ES may also indicate that the cur-
rent |_, measured by the clamp is too low.
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To reduce R, you can add one or more electrodes, 2 meters apart from each
other, in the H (Z) leg of the circuit, or increase the test voltage.

To reduce R, you can add one or more electrodes, 2 meters apart from each
other, in the S (Y) leg of the circuit.

To reduce the resistance of the electrodes, you can also drive them deeper, pack
the ground around them well, or dampen them with water.

10.1.4 Out of Limits Indicators

S This flashing during a passive measurement means that the device
—/&\— has detected the presence of an external voltage exceeding 42V on
the terminals and that the measurement is impossible.

S

ﬁ This flashing during an active measurement means that the operat-
ing limits have been exceeded.

If this symbol remains lit during an active measurement, it means
that the values measured are subject to large fluctuations or that
there is an incorrect connection.

m The display of an indefinite value for a passive measurement indi-
cates that measurement current I_¢ or I or voltage U . is too low.

The display of the NOISE symbol indicates that a stray external voltage is likely to
interfere with the measurement. You should change to manual mode and change
the measurement voltage and/or frequency in order to make a valid measure-
ment.

After the measurement has started there are indicators of when:
* Values R, and/or R, are too high,

* Measurement current |, ., I or I, is too low,

H-E’
* The instability of the measurement is large.
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Conditions that may give uncertain results are indicated on the display of the unit

as follows:
. . . Indication on the
Frequency Function Triggering threshold display unit
3P, 4P, V pot. le <6MA
f>513Hz 3
4Psel, GroundFlex® . <6mA® /\ flashes @
3P, 4P, p, V pot L. <1mA ® flashes
f<513Hz
4Psel, GroundFlex® L. <1mA®
f> 513Hz All (except p and 2 R, >5kO \
clamps) /\ flashes @
@ flashes
f< 513Hz All Ry >30kQ
4P sol L <1mA /\ flashes @
<
¢ es = 1M &AL flashes
/\ flashes @
G dFlex® le, <10 mA ‘( )
roundFlex SEL m flashes
Values measured (U, s
Al I, R) unstable, varying & steady
by more than 5% about § flashes
their mean values. @
ls < 3mMA
Roass Iy, <30 MA S flashes
Uge <10 mV
ls < 0,3mA
Reass lgg <3 MA -.--- (undefined)
Ugeg <1mV
Al Ugeo Ugp Uy > 42V /\ flashes @
Stray voltage of which
the frequency and/or (4)
All value is likely to inter- [NOISE |
fere with the measure-
ment.

(1) 1,¢" current |, . measured at the start of the measurement before |
(2) Not active if the SMOOTH function is selected.

(3) The VAN symbol may also appear if there is an external voltage > 42 V on the terminals of the device.

SEL *

(4) You should change to manual mode and modify the measurement voltage and/or frequency to make
a valid measurement (when the NOISE symbol is no longer illuminated).
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10.1.5 Error Messages

When started up, the Model 6472 device automatically performs a self-test. If a
fault appears during this self-test or during a measurement, the device displays a
message in the form Err XX.

There are 3 categories of errors:

Harmless

Correctable

Fatal

Errors 6, 7, 11 and 17

The message appears for approximately 1 second to inform
the user. Consider a repair if the error recurs.

* Errors 6 and 7 are always preceded by an automatic
reset.

* During Error 11, the tester automatically resets to the fac-
tory default settings.

Errors 5, 9, 14, 15, 18, 19, 30, 31, 32 and 33

These errors concern the current measurement function and
disappear if the function is changed. The device can therefore
be used, but a repair will be necessary if the error persists.

« Error 18 indicates that the rechargeable battery in the tester
cannot be recharged. If this error occurs during recharging,
disconnect the tester from the charger and follow the
procedure described in the “fatal” errors.

» Error 19 can be corrected by clearing the entire memory of
the unit (see section 8.3).

« Errors 31,32 and 33 indicate excessive voltage or excessive
current during a measurement. Check the measurement
setup for faults.

Errors 0,1, 2, 3, 8, 12, 13, 15, 16, 18 (during battery recharge)
and 21

These errors make operation of the unit impossible. Turn off
the unit and turn it on again. If the error persists, repair is
necessary.
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APPENDIX A: GLOSSARY

GLOSSARY OF TERMS

Basic Terminologies
Explanations for some of the basic terms related to earth measurements follow:

Auxiliary electrode - H (2)
A supplementary electrode through which a measurement current flows.

Earth conductor

The conductor which connects the installation to be earthed to the earth elec-
trode.

Earth connection

A locally restricted group of electrically connected earth contacts. It also in-
cludes metal parts of installations such as pylon footings, bracings, cable
sheathing and earth conductors.

Earth electrode - E (X)
A conductor which is buried in the earth and makes electrical contact with it.

Earth potential
The potential difference measured between the earth connection and a refer-
ence earth electrode.

Earth electrode - ES (Xv)

A connection on the earth electrode or earthing system used for measuring
the potential of the earth electrode.

Earth resistance

The resistance measured between the earth connection and a reference earth
electrode (cf. selective earth resistance).

Earth
The location of an earth connection (see also reference earth).

Earthing system
The set of all installations connected to the earth.

Electrode - S (Y)
An auxiliary electrode used for measuring the potential of the reference earth.
The voltage, which is proportional to the resistance of the earth connection, is
measured between this electrode and the earth electrode.

84 Ground Resistance Tester Model 6472



Reference earth

The area of earth (especially at the surface) which is outside the range of influ-
ence of the earth electrode or earthing system.

Resistivity of the earth (p)
Resistivity is defined as the resistance from wall to opposite wall of a cubic
meter of soil. It is measured in ohm-meters (Qm).

Selective earth resistance
The parallel partial resistance of an earth connection or earthing system. It
is measured by selective measurements of current in the corresponding re-
sistance branch. A selective earth resistance is always greater than the total
earth resistance (parallel connection).

Step voltage
The potential difference bridged by a person who takes a step of 1m (approx.
3 ft), with the resulting current flowing through the body from one foot to the
other (cf. touch voltage).

Supplementary electrode
An additional earth electrode (earth stake, earth rod).

Touch voltage
The potential difference which a person is able to bridge with his or her body,
the resulting current being limited by the body and the local earth resistance
(cf. step voltage).

The general term earth measurement can refer to measurements of individual
earth electrodes, earth connections or entire earthing systems, depending on the
object of interest.

Glossary

This glossary lists the terms and abbreviations used on the instrument and the
digital display.

3-Poles : measurement of earth resistance with 2 auxiliary stakes
(3-Pole method)

4-Poles : 4-Pole measurement of low earth resistance with 2 auxiliary
stakes (4-Pole method)

GroundFlex® : selective earth measurement using the GroundFlex® Adapter
Model 6474 and GroundFlex®sensor

C, . earth coupling coefficient R, with earth R, (C,.=R_./R,)
C, . earth coupling coefficient R, with earth R, (C,=R_./R,)
d, A . distances to be programmed to calculate resistivity according

to the measuring method used
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mQ

EARTH

: measurement of low resistance /continuity

: terminal E (X) - earth socket; current measurement return

terminal

: earth measurement (3 or 4 poles)

EARTH COUPLING : coupling measurement between two earth sockets

ES

H
I-Act

ES

H-E

SEL

NOISE

R+

. ES (Xv) terminal (measurement potential socket for

calculating earth resistance)

: H (2) terminal (measurement current injection terminal)

: external current circulating at present between the instrument

terminals

: current measured by the clamp connected to the ES terminal

(selective earth measurement with clamp)

: measurement current circulating between the H and E

terminals

: current measured via the GroundFlex® Adapter Model 6474

(selective earth measurement with GroundFlex®)

. indicates the presence of external interference causing

misrepresentation of the earth or resistivity measurement

: average resistance calculated from R+ and R-

: resistance measured with a positive current circulation from

terminal Hto E

: resistance measured with a negative current circulation from

terminal Hto E

. resistance currently calculated from values U-Act and I-Act

: first value measured to calculate the coupling between 2 earth

sockets (R, =R, +R.)

: second value measured to calculate the coupling between 2

earth sockets (R,=R +R.)

: third value measured to calculate the coupling between 2

earth sockets (R,,=R, +R,)

. first earth value calculated (R, =R, -R,)
: second earth value calculated (R, =R, -R.)

. coupling resistance between earths R, and R, (R, = (R, + R,

-R,,)/2)

. earth resistance connected to terminal E

. resistance of the stake connected to terminal H
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LOOP

PASS

. resistance of the earth loop measured with the "2 clamps"

function

: value of the R-Act resistance (PASS for "passive"

measurement with interference current circulating in the
installation)

. resistance of the stake connected to terminal S

. selective earth resistance (measurement of the current with a

clamp or GroundFlex®)

: resistance between stakes S and ES (used for resistivity

measurement)

: measuring lead compensation resistance

. S (Y) terminal (reference potential socket for calculating earth

resistance)

: external voltage currently present on the instrument terminals
: voltage measured between terminals H and E

: voltage generated by the instrument between terminals H and

E (32V or 16V)

. voltage measured between terminals S and E
: voltage measured between terminals S and ES
: frequency chosen by the user (from the English "user")

. voltage of terminal S (compared with E) expressed as a

relative value (rEL); value without unit

: ground potential measurement

: ground resistivity measured according to the Schlumberger

method (expressed as Q.m)

: ground resistivity measured according to the Wenner method

(expressed as QQ.m)

(1) The suffix Act becomes In (for "Input" in English) when this value is recorded by the instru-
ment and then read, to make a distinction between the current and recorded values. In both
cases, this value on the display is associated with its frequency.

(2) In this case, the resistances of the 4 stakes used for measurement are indicated by R

R

P-ES?

Ros

P-H?
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Repair and Calibration

To ensure that your instrument meets factory specifications, we recommend
that it be scheduled back to our factory Service Center at one-year intervals
for recalibration, or as required by other standards or internal procedures.

For instrument repair and calibration:

You must contact our Service Center for a Customer Service Authorization
Number (CSA#). This will ensure that when your instrument arrives, it will be
tracked and processed promptly. Please write the CSA# on the outside of the
shipping container. If the instrument is returned for calibration, we need to
know if you want a standard calibration, or a calibration traceable to N.I.S.T.
(Includes calibration certificate plus recorded calibration data).

Ship To: Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive
Dover, NH 03820 USA

Phone: (800) 945-2362 (Ext. 360)
(603) 749-6434 (Ext. 360)
Fax: (603) 742-2346 or (603) 749-6309
E-mail: repair@aemc.com
(Or contact your authorized distributor)

Costs for repair, standard calibration, and calibration traceable to N.I.S.T. are
available.

NOTE: You must obtain a CSA# before returning any instrument.

Technical and Sales Assistance

If you are experiencing any technical problems, or require any assistance with
the proper operation or application of your instrument, please call, mail, fax or
e-mail our technical support team:

Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
200 Foxborough Boulevard
Foxborough, MA 02035 USA
Phone: (800) 343-1391
(508) 698-2115
Fax: (508) 698-2118
E-mail: techsupport@aemc.com
www.aemc.com

NOTE: Do not ship instruments to our Foxborough, MA address.
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Limited Warranty

The Model 6472 is warranted to the owner for a period of one year from the
date of original purchase against defects in manufacture. This limited warranty
is given by AEMC?® Instruments, not by the distributor from whom it was pur-
chased. This warranty is void if the unit has been tampered with, abused or if
the defect is related to service not performed by AEMC® Instruments.

For full and detailed warranty coverage, please read the Warranty
Coverage Information, which is attached to the Warranty Registration
Card (if enclosed) or is available at www.aemc.com. Please keep the
Warranty Coverage Information with your records.

What AEMC® Instruments will do:

If a malfunction occurs within the one-year period, you may return the instrument
to us for repair, provided we have your warranty registration information on file
or a proof of purchase. AEMC® Instruments will, at its option, repair or replace
the faulty material.

REGISTER ONLINE AT:
www.aemc.com

Warranty Repairs

What you must do to return an Instrument for Warranty Repair:

First, request a Customer Service Authorization Number (CSA#) by phone
or by fax from our Service Department (see address below), then return the
instrument along with the signed CSA Form. Please write the CSA# on the
outside of the shipping container. Return the instrument, postage or shipment
pre-paid to:

Ship To: Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments

15 Faraday Drive « Dover, NH 03820 USA

Phone: (800) 945-2362 (Ext. 360)

(603) 749-6434 (Ext. 360)
Fax: (603) 742-2346 or (603) 749-6309
E-mail: repair@aemc.com

Caution: To protect yourself against in-transit loss, we recommend you insure
your returned material.

NOTE: You must obtain a CSA# before returning any instrument.
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